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INTRODUCTION TO FLTDUTY XLS 2.06  
FLTDUTY XLS 2.06 is a scheduling program designed for the Canadian commercial pilot in any 
type of operation except 705 airlines.  The program will record the pilot's schedule and make 
calculations to show current status with respect to the CARs (Canadian Aviation Regulations) in 
terms of accumulated flight time, flight duty time and rest.   

All entries are checked against the CARs requirements Part VII for Commercial operations, Division 
II, (or Part VI for Private operations, Subpart 4, Division IV) for compliance and for options available 
under the Standards.  The program applies Operations Specifications 092, 093 and 094 
automatically.  (If these Ops Specs are not in place check the menu item in Options or the check 
box on the startup screen for more restrictive limits.)  Operators with a multi-pilot staff as well as 
individual pilots can use the program. 

To use the program, load it into a PC (must have Windows 95 or higher) and complete entries each 
day for flight duty time and flight time.  This is generally 3 entries (report time, released time, flight 
time) once a day per pilot.  If the data is current, the program will display the status of the pilot in 
terms of accumulated flight times as required by the CARs and show when the next "time free from 
duty" (day off) must be.  If any limit is approaching, the program will indicate a warning on the 
display and in some cases offer options.  If any Regulation or Standard has been violated, the 
program will note these with an explanation and a reference to the specific CARs.   

Entries can be made in advance, to check that a proposed schedule will be in compliance, or 
entries can be made after the duty assignments to track and monitor pilot status as per CARs 
700.14(1).  In any case a record is developed and maintained with a constant check to the relevant 
regulations. 

GETTING STARTED 

USER's MANUAL 

The user's manual is included with the program as a file as a PDF document on the CD ROM in 
D:\User’s Manuals\FltdutyUsersManual.pdf.  Use Windows Explorer to see the contents of the 
FLTDUTY install CD ROM.  Double click on the user’s manual file name and Windows will open the 
file and display it in Adobe Reader.  Print for double sided printing to reproduce the manual.  

There are other README files on the CD as well including a Word version of the manual.  A 
sample form called Pilot Form.doc is a sample of a possible pilot form used for submitting duty and 
flight times to enter into the FLTDUTY record.   

SYSTEM REQUIREMENTS 

Computer:  Requires an IBM compatible PC running Windows 95 or higher.  The installation 
takes about 4 MB of disk space.  If space is a problem on your hard drive, you can delete the 
README file if you have a printed copy of the user's manual.  Your files will grow as your time 
progresses and the required space will reflect this.   

FLTDUTY XLS was originally run on an IBM compatible 486SX/25 MHz and ran quite slowly when 
the record period got more than a few months along.  The Auto Calculate feature helps to minimize 
the annoying wait.  Faster CPU's and any Pentium make short work of any of the calculations and 
have been very satisfactory. 

Controls:  FLTDUTY XLS 2.06 can be navigated with a mouse; or without a mouse using the tab 
key, Enter key, Esc key and the hot keys.  Using a mouse is simpler but takes hands off throttle and 
stick... 
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Display:  The design screen size was 800 x 600 pixels.  Larger screen sizes will show a partial 
screen for the display.  FLTDUTY XLS has been run on laptops and on home and office PC's with 
14" and larger monitors.  FLTDUTY XLS was also designed to accommodate 640 x 480 pixels 
screen size but the graphics are crowded.  Your Regional Settings must be set to English 
(Canadian) in Windows Control Panel.  (Click Start > Settings > Control Panel > open Regional 
Settings > select English (Canadian) from the list.  Under Date your Short Date format must be in 
the order dd/MM/yy.) 

Operating System:  FLTDUTY XLS was originally written using Microsoft's Visual Basic Version 
5.0 and was upgraded to Visual Basic Version 6.0 in February 2004.  It is compatible with Windows 
95 or higher. 

INSTALLING THE PROGRAM 

1) Insert CD-ROM in the drive and use Windows Start menu with Settings > Control Panel > Add 
Programs. 

 From your desktop, click on Start (left mouse button). 

 Move the mouse arrow up to Settings. 

 Move the mouse arrow to Control Panel and click. 

 Find the icon that says Add/Remove Programs and double click. 

 When the form comes up, click on Install.  Then click on Next and look for 

D:\SETUP.EXE to appear in the text box.  Click on Finish and SetUp will run. 

2) Follow SetUp to have the program written to your hard drive.  The program will be installed in a 
directory called "FLTDUTY XLS" in your root C:\ directory if you do not specify another location.  
(Use the default directory so updates and patches can be automatically incorporated.)  If you 
move the program after it has been installed, the uninstall feature will not work to remove it later 
if you change your mind, and later revisions may have to be manually installed. 

3) To start the program, use the icon now appearing in your Start Menu under All Programs.  You 
can also double click on the Fltduty.exe Application file from Explorer or My Computer in 
C:\FLTDUTY XLS.  You can also create a shortcut for your desktop from there or go to Explorer 
or My Computer and find C:\Start Menu\All Programs and create a shortcut (right mouse button, 
Create Shortcut) to the FLTDUTY XLS shortcut already there and drag it to your desktop. 

 

INSTALLING ON A NETWORK 

FLTDUTY XLS is not multi-user compatible in the strict sense.  There can be multiple copies of the 
program running at the same time, however, if different users are accessing the same pilot file at 
the same time in a network environment, there will be no protection of revisions.  Records will be 
overwritten as the files are saved (click Save or close the file) with the last one becoming the only 
version.  No provision has been made for exclusivity or concurrent revisions.  With these limitations 
in mind, FLTDUTY XLS can be installed on a network and accessed from workstations or terminals.  
Since the program uses shared files and Windows library files, each copy of Windows using the 
program must be updated with these files.  The Setup routine will make the needed entries but 
each terminal or workstation must run the installation Setup separately to become updated.   

Make the initial installation and manually enter the host/server drive as a destination for the install 
during Setup.  If you are using Windows NT or later, this must be on a machine with Administrator 
privileges.  Then do the installation again on each client/work station/terminal and use the default 

destination.  After Setup has run, use Add/Remove Programs to uninstall FLTDUTY XLS from 
each of the client computers (except the first one).  When the message Box comes up asking if you 
want to remove shared files, be sure to click No or Remove None.  Save the shared files on the 
client copy of Windows.  Create a shortcut to the server Fltduty.exe file and rename it FLTDUTY 
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XLS.  You can put this in C:\WINDOWS\Start Menu\Programs folder or on the Desktop of the client 
computer. 

Users should be cautioned about simultaneous revisions to the same file.  One way to avoid 
problems here is to have Single Pilot password security enabled.  Administrators must ensure that 
their revisions are done at a time when it’s unlikely there will be simultaneous entries from other 
users. 

 

CAUTION 

You should back up your pilot record files often to a portable medium like a jump drive or flash 
memory card and store away from your computer in case there is a major malfunction in your 
system and a program crash.  These files are recognizable by the pilot name and the Text 
Document designation (with ".txt" extension).  If you don't want to do this manually, there are 
several options from within the program but these take a little time to execute.  The command 

button BackUp on the program and Complete BackUp in File from the main menu bar will send 
you to the Export screen where you can select record(s).  Check Include Profile Information and 
browse to your desired destination or storage device, then click Copy. 

QUICK START OVERVIEW 

This program is used to keep a record or plan a schedule of "flight duty time" and "flight time" and 
ensures that you know whether or not the pilot is in compliance with the CARs requirements.  Make 
time entries for (1) report for flight duty, (2) released from flight duty and (3) total flight time during 
the period.  This will take constant updating like a logbook, but offers a clear picture of pilot status 
and requirements to meet the CARs minimums at any time. 

To get started without going through the rest of this manual, follow these steps.  If you run into 
trouble, break down and read the complete instructions... 

1) Install the program onto your hard drive by following 
SetUp. 

2) Open the program from your Windows Start menu.  
You will be asked to log in with your Company Name 
the first time.  (To change this later or edit the label, 
right click on the Splash screen during start up in 
subsequent sessions.)  When the main form loads, 
from File on the menu bar, click on New. 

3) Enter pilot's name as you want it to appear in the 
title section.  This can include other identification 
like aircraft registration, job description or license 
number.  Remember that this will become the 
filename so illegal characters will not be allowed 
and will be automatically replaced by a blank 
space. 

4) Enter the date you want the record to start.  This can be as far in the past as you are willing to 

make daily entries, or a future date if you've yet to start the job.  Click on Add.   

When the main screen appears, your choices will be in place. 
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5) For each date (select from the drop down list or click on the icon or Entry Date label to see 
calendar), enter the start time and finish time (in a recognized time format or 0800,1700, etc.) 
for flight duty time, and flight time (in hours and tenths of hours 4.2, 0.7, 8.5, etc.). 

6) To set the type of flight for this entry, click on Special and check the appropriate boxes for 
your operation.  When the prompt comes up for setting all future dates the same, you can 
decide if this is likely to be the type of flight for the rest of the record and reset the defaults to 
reflect this without later prompting.  You can change these settings at any time in the future.  
This prompt is merely to save time if the type of flight is likely to remain unchanged for some 
time.  Your choices will be shown at the top of Section 1. 
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7) To add notes or make comments that will be saved 

with your entry, click on Notes ON.    

To save to disk, click on Save.   Entries are 

automatically saved when closing a file using File, 

New, Close or Open, or on exit using Exit or the 

Windows close icon "X" in the upper right corner. 

If you need to refer to the CARs, click on CARs ON.  
If you are entering a schedule for a commercial 
operation, the relevant Part VII CARs will be displayed.  If you are entering a schedule for a 
private operation carrying passengers, the relevant Part VI, Subpart 4 CARs will be displayed.  
On startup both CARs are available - Part VII before Part VI.  Use the Search feature to look 
up key words. 

If you want a summary of your entries in a table, click on Table ON and enter a range of dates.  

To print the table, click on File, then Print Table.  Your printer must be set to landscape 

orientation if you choose too many of the columns to fit on the page from Options > Printout 

Options.  

You can add information for each pilot in the profile section.  Click on Pilot Records and enter 
current Personal, Licensing and Training information for the pilot. 

8) You can add as many pilots as you want to the list.  Click on File, then New from the main 

screen, or click on the New command button on the startup screen.  Each will have his own file 
and distinct record.   

9) You can group pilots (like those on a particular aircraft, or those on a base) who share 
common schedules then make a single entry that will be repeated automatically.  Click on 

Edit, then Edit Groups and create groupings from the list of pilot names you have already 

entered.  Select Groups option beside the pilot list box to see the groups.  Select and then 

make the common entry.  If flight times for the day are different, click All Pilots and enter the 
appropriate flight times beside each pilot name.  (For no flight time enter a zero here.)  Click 

OK and each pilot in the group will have the entry for that day added to his record.  

10) If you want a report for more than one pilot on any particular day, click on Daily Status 

Report, select the date and those pilots (or groups) you want in the table and click on Open.  

To print the report, click on File, then Print Table.  You can set the columns you want printed 

using Options > Printout Options, and set print font sizes. 

11) If you think you may want to use the security/password features, you should establish at least 

one person as having Administrative Level clearance right away.  Click on Options > Security 

> then enter a name (yours) and a password and select Administrative for clearance level.  

Click OK.  Repeat the password to confirm, click OK.  You can leave the security features de-
activated, but for future use, you have established your control over changes. 

CHECKING OUT THE DEMO FILE 

The demonstration file will be opened the first time you run the program. This is a made up 
schedule already past and complete, which shows the features you can expect if you enter your 
own data and come up against various limits and situations affected by the CARs. 

 To view the status on any date, click on the Entry Date box or move the cursor to highlight the 
Entry Date box in Section 1:  Pilot Entries.  This is a drop down list box.  By clicking on the drop 
down arrow beside the box with "Apr 1, 2000", you will be presented with 91 days of dates, 
beginning with April 1/00 through to June 30/00 in the demonstration file.  These have already been 
completely entered and you use the demo file to see the results of a complete schedule from the 
past.  To choose a date, click on the date in the drop down list.  You can also use the pop up 
calendar - click on the icon or double click the Entry Date label. 
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NOTE 

If calculations seem to be taking too long, click on View in the main menu bar on top of the screen 

and then ensure that Auto Calculate is not checked.  This will interrupt some of the calculations 
and offer you the choice to continue if you need more information.  You can search out a particular 
date and see the basic entries without taking the time to complete all the calculations.  Once you 

click on Calculate, some of the calculations are done.  If you need more, click on Actual to see the 
rest.  (On my ‘old reliable’ when the dates got farther from Day 1, I had been waiting 10-60 seconds 
for the calculations to complete...) 

 

With Auto Calculate OFF: 

Once you have selected a date and it is shown in the Entry Date box, only the entries that have 
been made for this record show in the boxes in Section 1, and the Notes screen.  Section 2 will be 

blank.  You can scan the entries and the notes by clicking the Notes ON command button and 
selecting entry dates.  Select dates by choosing from the drop down list or calendar or by advancing 
the dates with the Down Arrow key or decreasing dates by pressing the Up Arrow key when the 
cursor is in the entry date box (Page Up/Down changes date in 1 week increments).  To see the 

calculations and the pilot's status in Section 2, click on the Calculate command button next to the 
Entry Date box or press the Enter key when the cursor is in the Entry Date box.  The program will 
run, showing the hourglass mouse icon, and the schedule recorded in the demo file will be 
examined.  

 

With Auto Calculate ON (for fast PC's): 

If you have checked Auto Calculate, then all calculations will be done as you select new dates.  
Your dates can be changed by pressing the Down Arrow key or Up Arrow key and will increment or 
decrement by a day with all calculations presented in Section 2 as well.  Or you can select a new 
date from the drop down list or calendar. 
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A Quick Overview of the Demo File: 

This schedule starts on April 1, 2000 and is a 90-day record of a young pilot hired by a company at 
an airport where there is lots of flying going on.  He has a regular job and occasionally gets to fill in 
on other missions but, as you will see, comes up against many CARs violations.   

Here is a day by day summary of the schedule presented in the Demo File.  This is what has 
happened during the period in the demo file to cause the displays you see each date.  If you want to 
see how a flight or duty period has been entered, or the display when specific circumstances come 
up, select the date indicated from this table.  There are notes with most entries (click on Notes ON 
if the yellow back light is on) that describe the fictitious schedule in words and also describe what 
the program is doing for each entry. 

SCHEDULE FROM DEMO FILE 

April 1-5 5 consecutive days off before the start of the job. 
April 6-12 First days on the job getting settled in and some flying. 
April 13-14 2 days off 
April 15-24 Building lots of flight time. 
April 25 First warning that accumulated flight time may need managing. 
April 26-May 4 Continues flying every day with no break. 
May 8  Delayed due to unforeseen circumstances (as defined by CARs) to avoid 

violation. 
May 9, 10 No excuse - violation! 
May 11 Violation even with unforeseen circumstances... 
May 12  Too much flight time - now requires at least 2 days off. 
May 20-24 5 day break 
May 25 Goes On Call (less than 1 hour). 
May 28  36-hour rest satisfies On Call requirement for rest. 
May 29-June 8 Takes on spray job with associated split duty days and limits. 
June 9-13 5 day break 
June 14-20 Spray job and other duties - very busy... 
June 21  Gets a break and flies right seat for commuter - violation on accumulated flight 

times... 
June 22 Does single pilot IFR duty - violation on daily flight time limit. 
June 23 Recreational flying on a day off - OK 
June 28 CARs Day Off, even with flight duty time, after 24 consecutive hours free from 

duty. 
June 30 LAST DAY Emergency call in for medevac and full day - lots of violations... 

 

You can enter changes in the Demo File to see the effect of various options in scheduling or "What 
if...?" scenarios.  The program will accommodate your changes and calculate accordingly.  When 
you close the Demo File your revisions will be lost and the original file will come back the next time 
you open the demo.  Your changes are not saved to disk but are stored and acted upon until you 
close. 

Once you have seen the Demo File and are comfortable using this program, you can delete the 
Demo File after you have begun your own file or files. The DEMO FILE item in the Pilot Name list 
box will be erased permanently.  If you are the only pilot name on the list, when you start up the 
program the main screen will come on with your file active without going through the open file 
screen. 

ENTERING A NEW PILOT RECORD 

To start a new pilot record, from the main screen click on File on the main menu bar and then click 

on New.  Or from the initial screen on startup, click on New.  A yellow background frame will appear 
with the cursor flashing in a box for the new name.  
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1. Enter the new name as you want it to appear at the top of the main screen later.  DO NOT USE 
"DOUBLE QUOTATION MARKS".  Your entry can be all capital letters, initials, include job titles 
along with the name or any other combination you wish to see.  For example:  ERIC BRADLEY       
Tanker #24 will show the name in capital letters and the aircraft fleet number following 5 
spaces.  Remember that the file name the program uses for future reference internally will be 
created here.  The rules for Windows 95/98 long file names apply.  Illegal characters will be 
automatically replaced with a blank space.  You cannot have two files for the same pilot under 
the same name (the program will warn you of a duplicate name). 

2. Enter a start date for the new record using a recognized date format.  This date will be Day 1 
for the record and no earlier dates will be accepted once this has been set here.  The default 
date of today's date appears here initially but you can enter any past, present or future date 
depending on when you want to start using the program.  However, if you do not enter accurate 
and complete data for past dates, some calculations will be off for as much as 1 year 
(accumulated flight time totals)...  

3. Once you are happy with the new file name and start date, click on Add (or press Enter).  The 
Pilot Name list box will be updated to include your new file (listed in alphabetical order) for when 
you next open the program.  The new file will be opened for you to make entries.  The default 
date will be today's date or Day 1 whichever is appropriate and the schedule will be blank. 
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THE PROGRAM COMPONENTS 

SECTION 1:  MAKING ENTRIES 

Single Pilot 

Once you have opened a file (selected a pilot name from the list; double click or click on Open), the 
main screen will appear with the pilot name in the dark blue title section on the upper left of the 
screen and the start date for the record in the upper right of the screen. 

NOTE 
The main screen is divided into Sections. 

 Under the main menu bar (standard Windows feature) with File, Edit, View, Options and Help is 
the dark blue Title Section with the pilot name and start date.   

Below that is Section 1:  Pilot Entries.  You will make entries in this section for the date you have 
selected. There are boxes for your flight duty schedule and your flight times.   

Below that is Section 2:  Calculations where you will see the results of the calculations for the 
schedule you have entered in Section 1.   

To the right of Section 2 is the command button section with the main buttons to click. 

You will normally only make entries in Section 1.  First select a date in the Entry Date box.  You 
can type in a date using a recognized date format, or you can select from the dates presented in the 
drop down list.  There is also a calendar for easier reference.  To select a date from the calendar, 
click on the icon.  The program will only accept future dates no more than 120 days ahead of 
today’s date each session and none before your start date.  (To get more usable dates, close the 
pilot record and re-open for another block of eligible dates.)  Once your selected date appears in 

the Entry Date box, you may make entries that will be stored with this date, or you may view the 

status in Section 2 for what has already been entered for this date by clicking on Calculate.  (With 

Auto Calculate checked this is automatically done as soon as you select a date that has previous 
entries.)  For your first time on any particular date, the default entries will initially be offered to copy 
the previous day's entries and no automatic calculation will be done. 

1) To make entries for flight duty time and flight time, place the cursor in the Report for Duty box 
and enter the time you started your flight duty (either for a flight or for standby) in a recognized 
time format (or a 4 digit time notation on a 24 hour clock like 0800 or 1730).  

2) Move the cursor to the Released from Duty box and enter the time you finished your flight 

duty.  (See the definitions in the CARs by clicking CARs ON, or check in the glossary at the 
end of this manual.) 

3) If you made a flight or series of flights, enter your total flight time for the duty period in the 

Flight Time box in hours and tenths. (like 3.2 or 0.5).  {Optional:  In the PLUS Edition version, 
any flight time entry will bring up the Flight Time Detail window to allow you to associate the 
flight time with an aircraft type and also allow you to enter any recurrency or recency items that 
you want to track in addition to flight and duty time (like Night TO’s and landings or IFR 
approaches or IMC time).}  

4) Click on Special to see the list of options for the type of flight.  Choose your type of operation 
and any special circumstances that apply.  You may need to check more than one box.  

 Commuter operations are Subpart 4 (704) operations, scheduled and passenger carrying.   

 Also check Non-sched DHC-6 or Heli if using Twin Otter or helicopter for non-
scheduled passenger operations for exceptions under CARs. 
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 Deployed operations are those operations operating from a remote base for more 
than 10 consecutive days.  These operations can replace the requirement for 3 
consecutive calendar days free from duty within each 17 day period with a requirement 
for 4 consecutive calendar days free from duty within each 19 day period. 

Note:  As of 05/05/05 this amendment is still a proposal and has been coded into 
FLTDUTY but with a reference to the proposed Standard. 

 Also check Non-sched Summer Hrs for non-scheduled on demand operations using 
the increased flight time limits and 48 hour/12 day rest cycle during the summer 
months for alternative requirements under the CARs. 

Note:  As of 05/05/05 this exists as an Exemption to the CARs and is available to 
operators under specific conditions for specific time periods.  FLTDUTY applies the 
conditions and restrictions if this option is checked here. 

 Aerial Work operations are Subpart 2 (702) operations, nonscheduled with passengers or 
not. 

 Air Taxi operations are Subpart 3 (703) operations, nonscheduled with passengers. 

 Airline operations are Subpart 5 (705) operations, scheduled with passengers and are not 
included in FLTDUTY calculations (although flight time can be entered). 

 Private Operator operations include many corporate and government operators not 
conducting operations under CARs Part VII but subject to some flight duty time, flight time 
and rest limitations.  These operations are passenger carrying, using turbine, pressurized 
or large aircraft.  See the CARs text for Part VI by clicking CARs ON for the differences.  If 
you have this box checked the text box will contain the Private Operator regulations and 
standards. 

 Helicopter are rotary wing operations and could be of either Subpart 2 or 3 or Subpart 4 or 
5.  (Check both here and the Subpart box to set your type of operation.) 

 Recreational flying should be included in your record but no flight duty time is associated 
with this type (you will need to leave the Report and Released times blank).   

 Fire Suppression operations do not have the increased rest limits as a result of being On 
Call under a Transport Canada national exemption with no immediate expiry date nor any 
plans to incorporate this rule into the CARs. 

Note:  This exemption has been coded into FLTDUTY for air tanker operators. The national 
exemption expires regularly but will probably either be extended indefinitely or eventually 
incorporated into the CARs. 

 Single pilot IFR flying carries some daily limits under the CARs.  

 Aerial Application operations have some special considerations for split duty days.  
(Check here and Aerial work box.) 

 Heli-logging operations have specific limits - single and 2 pilot operations.   

 If you were on call (as defined by the CARs), check the box labeled On Call and enter the 
start and finish times for your period of responsibility in the yellow shaded boxes that 
appear below the report for duty and released from duty boxes.  If there was overlap with a 
flight duty period, enter the start time for the earliest On Call and the end for the end of the 
latest On Call in the on call boxes.  On Call is not considered flight duty.  If you were on call 
for part of the day and on flight duty for part, enter the flight duty period normally and the on 

call period in the yellow boxes after you have checked the On Call box.  It is important that 
you enter your on call schedule so that the program treats the day differently from a day off.  

Entries here will affect your rest periods but not your flight duty times.  The On Call check 
box is not available if your flight time for 30 days is over 100 hours, as per the CARs.   
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 If you were on reserve (as defined by the CARs), check the box labeled On Reserve and 
enter the start and finish times for the period in the yellow shaded box the same as for an 
On Call period.  On reserve is not considered flight duty but is also not considered time free 
from duty.  Entries here will affect your rest period but not your flight duty time. 

 Emergency Life saving MEDEVAC is allowed during a required rest period or when an 
extension to the maximum flight duty time is necessary.   Use this option only when a 
violation might otherwise occur. 

Note:  As of 05/05/05 this amendment is still a proposal and has been coded into 
FLTDUTY with reference to the proposed Standard. 

 Unforeseen circumstances as defined by the CARs can allow some extensions to limits 
and prevent violations in specific cases.   

 An early recall from reserve status (less than 10 hours notice or a call in the middle of the 
night) has consequences for flight duty time and the following rest.  

For some of these special types of flight, after you have checked the box, a message will come 
up asking if you want to change the default to reflect this change for all future flights.  For 
example: If you are flying under Subpart 4 and expect most of your entries will be the same, 
choose Yes here and you won't have to make this selection for each future entry.  If you do 
make another type of flight, you can always reselect this option to change it back at the time.  If 
you don't expect to repeat this type of flight, choose No and only the current entry will show this 
special condition. 

When you have checked at least one of the options from this list that has a direct affect on 
CARs limits, a yellow "back light" will show around the command button, if you come back to 
look at this date, to indicate that special circumstances apply to the calculations on that date. 

5) If you have had a split duty day or more than one duty period during the day, click on Split and 
another set of entry boxes will appear below your first duty period.   

Enter the second duty period the same way.  Enter your duty periods in chronological order 
(first one first), and don't have any overlap between your duty periods. 

6) Once you are satisfied with your entries, click on Calculate and the program will calculate the 
status up to that point.  If you have made a mistake or want to change the entries on any 

selected date, click on Reset and all boxes and calculations will be set to blanks.  You can 
make changes by just deleting and re-entering data in any box in Section 1 the usual way at 

any time.  Remember to click on Save after making changes and permanently register the new 
data.  The new entries are automatically saved when you exit or close a file. 

Group Entry 

You can make a shared entry and have it automatically repeated for each pilot in a group (or 

groups) as defined by you.  Assign pilots from your list to groups by clicking on Edit > Edit Groups 
in the main menu bar. 

When you select Groups option from beside the pilot name list box, you will see the names of the 

groups you have created.  To make a shared daily entry, select the group name(s) and click Open.  
Make the entry in the new form.  Select a date (use the calendar by clicking on the icon), then enter 
the Report and Released times.  Enter the flight time, if any.  If the flight times for the individual 

pilots in the group are different, you can make separate entries by clicking on All Pilots.  First enter 

a flight time in the original flight time box, then click on All Pilots, then make the adjustments for 
each pilot.  A blank entry in the individual pilot list will be filled by the entry in the original flight time 

box.  For no flight time, enter a zero here.  Click on Special to change the CARs limits if necessary 
- the defaults will be offered initially and may not need to be changed.  You can enter Notes, 

Optional Parameters, Split shifts and Actual rest times the same as on the main screen.  Click OK 
to start the common entries.  Each pilot file will be opened and the entries made.  A Warning 
Advisory box will appear if there have been any warnings or violations as a result of your group 
entry for the entry date. 
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SECTION 2:  GETTING RESULTS 

The calculations take longer, the longer the record up to 365 days.  Airline 705 operations will not 
have calculations completed or displayed. 

Once the schedule and flight times have been entered for a date, the program calculates and 
compares all the previous entries against the specific requirements from the CARs and displays the 
results in Section 2:  Calculations (Status on Entry Date).  This section is further divided into 4 
frames dealing with different CARs requirements.   

The first frame shows Daily Times.  It initially has a box showing the calculated maximum flight 
duty time in hours and the rest period since last duty in hours.  These are the maximum times 
determined from your entries on the entry date and the previous day or whenever the last duty 
period was ended.  The maximum flight duty time is the longest single entry (consecutive hours of 
flight duty) in any 24 consecutive hours that has been entered as flight duty time.  This includes the 
flight duty time on the previous day.  The rest period is the longest possible period for rest and, in 
an overnight situation (less than 24 hours since last duty), is calculated with 1 hour subtracted from 
the gap in the flight duty schedule to allow for meals, hygiene and travel.   

If a split duty day has been entered, the frame will also have a box showing the midday rest period 
in hours, calculated from the schedule you entered with 1 hour taken off for meals/hygiene.. 

If you have some reason to disagree with the rest calculations, because of something the program 
has not considered, you can manually make entries in this frame to reflect what has actually 
happened and all further calculations will be based on your adjusted entries.  (This might happen if 
you don't get the rest indicated as possible because you were on other duties besides flight duty.)  

To make the changes, click on the Change command button and a new label and box will appear in 
which you can make an entry.  Leaving the box empty will result in the calculated values 
reappearing, but any entry you make as an adjustment will be labeled as Actual for later viewing.  
Generally it is not necessary to enter the actual rest unless it is below the minimum required.  The 
program checks that the minimum rest required is possible and then ignores any excess.  

After you have made your changes, click on Calculate.  New calculations will then be made using 
the adjusted values. 

The second frame in Section 2 shows Accumulated Flight Times *.  It has boxes showing the 
flight time for the previous 7, 30, 42 and 90 days based on your entries up to the entry date.  There 

is also a command button labeled More in the frame that when clicked, will show the accumulated 
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flight times for the previous 180 and 365 days.  These time periods are all relevant to the CARs and 
have associated limits.  The 30, 42 and 90-day totals can be reset to zero in some types of 
operations after 5 consecutive days off, as per CARs for a limited number of times in a year.  The 
totals are calculated values and you cannot change them here.  If a total is incorrect, the previous 
entries are inaccurate or incomplete.   

If you double click on the white area of this frame or the title beside the asterisk, you will see the 
history over the past year of your options to reset your flight time totals to zero.  This may be 
important for use of the High Limits as allowed under the Standards  (CARs 720.15 and 720.16).  
You may have unnecessarily used a block of 30 days to reset flight time totals to zero when you 
later needed the block.  Or you may have declined to reset your flight time totals to zero and 
subsequently had higher flight times than anticipated and approached or gone over a limit.  To 
change your mind about resetting flight time totals to zero, you need to return to the date following 
the 5 day break, clear your entries by clicking the Reset button (be sure to write down the schedule 
and flight times first) and make your entries again and click Calculate.  Select the appropriate option 
to reset your flight time totals when the message appears again. 

When the record period does not go back as far as the desired accumulated time, the labels and 
the values are "greyed" to indicate that the total is based on a lesser period and all days prior to Day 
1 are assumed to have been days off with no flight time.  This may or may not be true and is 
affected by how willing you are to go back in your logbook and schedule to copy the information into 
this record.  If you choose to look ahead rather than back, you may have some inaccuracies until 
your record extends into each specific period or you reach a reset point after a 5-day break.  This 
will take up to 1 year for the 365 day total...  Other values will become accurate more quickly, 
especially if there is a 5-day break early in the record and your type of operation allows resetting to 
zero. 

The third frame in Section 2 shows Accumulated Days Off .  It has boxes showing the number of 
days off (as in "24 consecutive hours free from flight duty") in the previous 30 days and 90 days.  If 

you have Auto Calculate OFF, this frame will also have a command button labeled Actual.   

With Auto Calculate OFF the program stops looking for days off in your record as soon as the 
specific requirement for the CARs has been met.  The number in the box will show the minimum 
and a "+" (plus sign).   "3+" means that more than the required 3 days off in 30 days are in the 
schedule or "13+" means more than the required 13 days off in 90 days are in the schedule.  In 
other words, no violation has occurred. The labels and values will be "greyed" if days prior to Day 1 
are assumed to be days off.  If this information is not complete enough for your examination, click 

on the Actual command button and the calculations will continue for the full period and give an 
actual count of the days off in the period.  This takes some additional time. 

If you have checked Auto Calculate ON, this frame will show the actual days off in the periods and 
you'll probably not notice the extra time taken.  The program again assumes all days prior to Day 1 
of this record were days off and will count those in the 30 and 90 day periods until later in the record 
when actual entries will be used.  If this is not the case, you cannot change the values here.  You 
may wish to start your record earlier to get accurate 30 and 90-day values for today, but you will 
lose all your entries when you start a new record so make this decision early in the record period or 
not at all.  The labels and values will be "greyed" when the record period is less than the 30 or 90 
days.  

If you have entered a split duty day (aerial application) or an on 
call period and this now defines the limit until a mandatory day 
off, a note in italic print will appear over the 30-day value to 
indicate to you that the CARs requirements are changed as a 
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result of these special cases.  When the special requirement is met, the note will disappear.  No 
note means some other factor besides a split duty or an on call day has determined the first 
mandatory day off.  A split duty day in aerial application means 5 days off in every 30-day period 
and an on call entry means 36 hours of rest within 7 days or 3 consecutive days off within 17 days.  
In either case, the note will correspond to the mandatory days off dates in the next frame. 

The fourth frame in Section 2 shows Next Mandatory Days Off.  There is a box showing the 
number of days to go from the entry date until a "mandatory day off" as prescribed by the CARs 
requirements. There is also a box showing the date of that next mandatory day off.  Below the date 
box are two more dates showing the second next and third next mandatory day off which may be 
consecutive with the next mandatory day off or not.  Knowing the potential mandatory holidays may 
help in planning your future schedule.  These dates are determined by the entries you have made in 
your record and the CARs requirements.  Various factors, including the type of operation, the 
spacing of your previous days off, your accumulated flight time totals near a limit and whether or not 
you have had a split duty day or an on call period, affect the date of your next day off.  Any days off 
as they occur may cause the next mandatory date to shift. 

The program calculates this date as if there are no days off between the entry date and the next 
mandatory date.  This means the date showing here is the latest you can go without a 24 
consecutive hour period free from flight duty.  A date far in the future should cause no real concern 
if days off are expected or possible due to weather or scheduled time off, but as the "days to go" 
approach 1 your options diminish until you must take tomorrow off. 

There may also be an icon showing a large “36”, “48”, “80” or “DDD” and a date and time line of 
text.  These icons appear in an On Call period or in Airline or Commuter operations and indicate the 
option that is in place to give the least restrictive limits for time free from duty at any point in time.  
The line of text indicates the exact date and time by which at least 36 hours of rest must be 
scheduled and completed to begin another cycle.  When the countdown gets to 1, then at least 36 
hours must be scheduled prior to the next flight duty period.  Double click on the icon or pause the 
mouse over it to also see the actual limit for getting in the rest. 

If a 3 date rest has been given, the “DDD” icon will show.  Following the rest the Days to Go 
countdown will start at 14 days for the 17 day cycle.  If an 80 hour rest has been given, the “80” icon 
will show and the countdown will also start at 14 days for the 17 day cycle.  If a 48 hour rest has 
been given (after May 1/02 when this exemption came into effect) during the summer months (May 
to September) for 704/705 non-scheduled operations, the “48” icon will show (You must check Non-
sched Summer Hrs under Special to use this exemption) and the countdown will begin at 10 days 
for the 12 day cycle.  If a 36 hour rest has been given, the “36” icon will show and countdown will be 
from 5 days for the 7 day cycle.  The minimum rest following any duty is at least 36 hours to begin a 
7 day cycle.  More rest may qualify for a longer cycle and FLTDUTY will allow and calculate based 
on the least restrictive limits available following the rest.  Some rest may not extend the next day off 
requirement if there is no benefit (ie.  A 36 hour rest early in a 17 day cycle would not allow any 
extra duty - the 17 day cycle is still the least restrictive.) 
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Under some circumstances there will be a fifth frame over the fourth frame or instead of it.  This 

frame shows the Extension Option.  This is an option under the CARs for replacing the 3 days off 
in 30 days requirement with 5 consecutive days off in 42 days (CARs 720.19).  Sometimes, when 
the prerequisites have been met, this option is available 
for a limited time period.  In the fourth frame there is a 

command button labeled 5/42 (for 5 days off in 42 days).  
If the printing on the label is not "greyed", then the option 
is available for scheduling purposes and no violation will 
occur if you go more than 30 days with less than 3 days 
off.  To see what option the extension offers, click on the 

5/42 command button.  If the option is available, the frame will change to show the days to go using 
the option and the dates of the next mandatory days (all consecutive because the requirement after 
using the extension is for 5 consecutive days off).  This will always be more than the regular 3 days 
off in 30 but may not necessarily be much more (at most 12 days).  To show the regular frame 

again, click on the same command button now labeled 3/30 (for 3 days off in 30 days)   

If you have gone through the 30-day requirement without at least 3 days off, and the extension 
option is available, and if there has been a stretch of consecutive flight duty assignments extending 

more than 30 days (CARs 720.19 (1b)), the fourth frame in Section 2 will be the Extension Option 
frame and you will be committed to the requirements for using the extension rather than incur a 

violation under the 3 days in 30 days rule.  The 3/30 command button is disabled because you no 
longer have the option of taking 3 days in 30 and you are required to take 5 consecutive days off to 
satisfy the CARs.  The program moves automatically into the extension option which commits you 
to a 5-day break, rather than show a violation of the CARs.  If you want to decline to use the 
extension option, you are given the choice on the first day.  If you decide not to use the extension 
option, you will incur a violation of the CARs on that day and every day until you have regained a 
total of 3 days off in the previous 30 days.  This may be better in some cases than waiting for the 
extension to expire and then being in violation every day until you have had 5 consecutive days off 
(this may never happen in a busy season...).  A single violation now may be better than many 
violations later - in any case you will be caught short.  The best scenario is to heed the warnings 
given by this program to avoid having to make this type of decision.  If you later change your mind 
about declining the extension option, you can go back to the first day of the extension, click on 

Reset to void your entries (including checking the Decline Option box) and re-enter your schedule 

and flight times as they were but when the choice comes up again, leave the Decline Option box 
unchecked. (Changing your mind back again will involve the same reset and also, to reset all the 
following dates, you must move to the next day and make the calculation, the rest of the affected 
dates will be adjusted back so that the extension is in use.) 

The final frame in Section 2 shows the CARs Violations, if there are any, as a result of the entries 
you have made.  The violations will be described in a few words in a list box.  To get the specific 
CARs reference for particular violation, double click on the description line and a message box will 
appear over the main screen.  For a complete version of the relevant regulation or standard, click 
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on the CARs ON command button and look it up.  The auto lookup feature will present the 
reference initially.   

THE COMMAND BUTTONS 

There are 8 command buttons in the section at the right of the main screen:  Save, Table ON, 

Notes ON, CARs ON, Pilot Records, Aircraft Records, BackUp and Exit.  The Table ON, Notes 

ON and CARs ON buttons change to Table OFF, Notes OFF and CARs OFF when the options 
they control are presented.  At the top of this section is a day counter that indicates the number of 
days from the start of the record. 

Save:  Use this button after you have made or changed entries on a date. When you click on the 

Save button the program does the calculations and permanently saves the entries you have made 

by writing to the data file.  This button can be used instead of Calculate and results in a permanent 
record but takes more time. 

Table ON:   Means "Do you want the Table presentation turned ON?"  Click on this button and you 
will be presented with a different screen with 2 sections.  Section 1:  Pilot Entries is where you can 
enter a range of dates if you are interested in a table of values showing most of the information 
presented for each day in the main screen.  Enter a "start date" in the appropriate box in a 
recognized date format that is within the record period and an "end date" the same way.  If you 

have Auto Calculate OFF there is an option box for calculating actual days off for the table with a 

warning that this will take more time.  Once you are happy with the range of dates, click on Enter 
and the program will process each day in your range and develop a table summarizing the 
calculated values.  The time involved is roughly the same as taking the time for calculating a single 
day and multiplying it by the number of days you have requested.  (If your normal single day 
calculation takes 10 seconds, 20 days in the table will take about 3 minutes to finish...)   

Once the table has been developed, it will be shown in Section 2: Table of Calculations with scroll 
bars where needed.  From the table you can get an idea of the total season rather than just a single 
day perspective.  You can see trends and count days off, violations etc.  On the table at the top right 

are two more command buttons.  If you have Auto Calculate OFF, the Show Days Off button will 
let you display actual days off for the dates you have selected if you find after the table has been 
made, you want this information.  The time taken will be as long as if you had first selected this in 

the initial calculation because the program goes back and recalculates every day.  The Reset 
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Dates button brings back the Section 1 frame and allows you to choose another set of dates for a 
new table.  

To see the main screen again, click on Table OFF.  The table will stay available, even if you click 

Table OFF, until you exit or select another pilot in a multi-pilot setup. 

Notes ON: Clicking on this button brings up another frame over Section 2.  Within this frame is a 

large box labeled Notes in which you can make notes and store miscellaneous data as you want.  
The information here is stored as text and cannot be acted on by the program, but any notes will be 

saved with the date for which you made them.  If you select "Line #1 of Notes" from Options > 

Printout Options in the main menu bar, the first 20 characters here (or until you skip to the next 
line) will show for each day in the tables.  You might want to include route or aircraft information to 
customize your reports. 

Beside the Notes box is an area that contains boxes for you to keep track of anything you want and 
carry as a total.  The labels for these options can be set by you (at initial startup or anytime you 
decide there is something you want to keep a running total on) and will be saved and reappear each 

time you start the program (See Options > Optional Parameters on the menu bar).  You might 
want to keep a running total of hectares sprayed, tons of cargo, mileage, passengers, dollars 

earned or whatever, depending on the nature of your business.  You can reset the totalizer (Total 

to Date) value to zero by clicking on the check box at the lower right.  The To Date total will be zero 
for the next day and increment from there.  All previous totals will remain and be displayed as you 
made them whenever you select those previous dates.  You can use this feature when switching 

from job to job or season to season.  Entries in the Notes frame will be saved automatically but to 

see the results of an entry (Total to Date) you will need to click on Calculate. 

To see the main screen again, click on Notes OFF.  If you have made an entry in the Notes frame, 
a "back light" (yellow bars) will come on around the command button whenever you select that date 
to indicate that there are notes associated with this date. 

CARs ON:  Clicking on this button brings up a frame containing the Canadian Aviation Regulations 
relevant to this program.  The frame covers Section 2 of the main screen and you can look up the 
regulations and standards by scrolling through the text or use the key word search feature.  This 
copy is up to date as of January 1/03 (with some inclusions for proposed amendments not yet 
incorporated in the CARs but effective under NPA’s, Advisory Circulars and Exemptions).  The 
calculations are done based on the regulations and standards presented here.  For significant 
changes to the CARs, I will try to send out updated versions of the program.  Nothing stays the 
same... 

To see the main screen again, click on CARs OFF. 

Pilot Records:  Clicking on this button will bring up a form for entering Personal, Licensing and 
Training information for the pilot.  Enter information for the pilot as a reference for currency 
requirements.  Warning colour changes will appear at 30 days (or your set period) before due.  The 
Options can be set to anything you want by clicking to highlight the labels and typing your own 
description.  The labels will stay and you can make entries in the text boxes normally. (There is an 
add-on which has expanded capabilities in this area for those users interested in computerizing 
their training records in a customized format.  See PLUS Edition.) 

Aircraft Records: (Add on)  In the database version of the program, aircraft movements can be 
monitored for your fleet.  You can enter flights and then get summary information in reports on 
levels of activity and aircraft use through queries and searches.  You can upgrade to have this 
feature enabled at any time.  See PRO Edition. 

BackUp:  Clicking on this button will bring up the Export features window.  Be sure to have a 
portable media in the drive when you want a backup made (flash drive).  Select the pilot name and 
check to “Include Profile information” and “Include Label text” if you want the training/licensing and 
custom label formatting saved.  The backup will save your most current entries prior to writing to the 

on disk.  You can also use File > Import/Export > Export Pilot File to create a backup. 
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Exit:  Clicking on this button will end your session, save all entries in a separate file and exit the 
program. 

MAIN MENU BAR 

The menu bar at the top of the screen is a typical Windows feature and operates in the standard 
way.  Most of what is contained in the menu bar is duplicated by command buttons on the main 
screen and option screens. 

 

File:   

 Click on File on the menu bar and a drop down list will appear as you expect.  Click on New to 
close the file you have open and bring up the initial startup screen with the New Pilot entry options 
available.  Calculations will be blank until after you have opened a new file (and clicked on 

Calculate with Auto Calculate OFF).  Your old file will be saved with all your recent changes.  
Use this when you have a new pilot to begin a file. 

 Click on Open when you want to close one file and open another for another pilot already on the 
list.  This will blank the calculations and present the initial startup screen for you to select another 
pilot name from the list. 

 Click on Save to permanently store new entries.  (Same as Save command button.) 

 Click on Close to close one file and open another for another pilot already on the list.  This will 
blank the calculations and present the initial startup screen for you to select another pilot name 

from the list.  (Same as Open.) 

 Click on Printer Setup to see the current settings for your printer.  You can select the appropriate 
paper orientation and other features. 

 Click on Print Schedule to get a hard copy of the data you have entered.  Another frame will 
appear asking for a range of dates to be included in the printout.  Select the range within the 

record period, be sure that your printer is ready to go and click on Print.  A table will be printed 
that shows the entries you have made for the schedule each day without any calculations.  "No 
Flight Duty Time" here means a day without entries, not a CARs day off   (No duplicate control on 
the screen.) 

 Click on Print Table to get a hard copy of the table you have produced.  This option is only 
available after you have made a table.  The printer may need to be in landscape mode for this 

operation if you have selected many columns to print from Options > Printout Options.  The 
table will be printed as it has been made for Section 2.  (No duplicate control on the screen.) 

 Click on File Import/Export to move pilot files between copies of FLTDUTY XLS in an operation 
that has more than one base with multiple copies of the program and pilots transferred between 
bases regularly.  Pilot Name.txt files can be manually copied, cut and pasted using My Computer 
or Explorer but this internal method allows for the transfer of files directly.  (This is not the same 

as BackUp or Complete BackUp as files can be either moved or copied - both in and out.) 

 Click on Complete BackUp to have all your pilot records copied to a safe destination.  Be sure to 
have a flash drive in the USB port.  Select all and Copy.  This can be your backup disk but all files 
will be overwritten.  

 Click on Exit to save your entries, close your file, end your session and shut down the program.  

(Same as Exit command button.) 
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Edit:   

 Cut, Copy and Paste are standard Windows features that allow edit functions to and from text 
boxes.  The CARs text cannot be altered although selected strings can be copied and pasted 
elsewhere (such as to the Search text box).  Keyboard shortcuts are standard Ctrl + X, Ctrl + C, 
Ctrl + V. 

 Click on Split Duty to bring up extra time entry boxes for more than one flight duty period in a 

day.  (Same as Split command button in Section 1.) 

 Click on Change Whole Entry when you want to reset the entries for the date all to blanks and 

start again.  (Same as Reset command button in Section 1.) 

 Click on Actual Rest to allow actual times to be entered for Rest in Daily Times in Section 2.  

(Same as Change command button in Daily Times in Section 2.) 

 Click on Edit Groups to add/modify/delete pilots to groupings for shared entries and reports.  

(Same as Edit Groups in Daily Status Report selection screen.) 

 

View:    

 Click on Auto Calculate (ON for faster PC's) and a check will appear beside the label and 

calculations will be completed each time you select a new date.  With Auto Calculate OFF, 
calculations will be interrupted somewhat to give partial values and speed up the analysis time.  

You will need to click on Calculate to have calculations for the entry date completed.  (Same as 
the check box in the startup screen.) 

 Click on No Ops Spec 092, 093, 094 if your operation does not have these Operations 
Specifications from Transport Canada appended to your OC.  These Ops Specs allow you to use 
the higher flight time, duty time and reset your flight times to zero options available in the 
Standards.  FLTDUTY will calculate your limits based on the Regulations only if you check here.  
(Same as check box in the startup screen.) 

 Click on Show Actual Days Off Totals and the calculations will continue for the entry date to 

show actual days off rather than just enough to satisfy the CARs.  (Same as Actual command 
button in Section 2.) 

 Click on Show 180/365 Day Flight Times to see the longest 2 periods of accumulated flight 

times in Section 2.  (Same as More in Section 2.) 

 Click on Calendar to see a pop up calendar from which you can select dates for entries instead of 
using the drop down list, incrementing with the Up Arrow and Down Arrow keys or typing a date.  
The calendar can be used to select Entry Dates, to set start and end dates for making a Table 

and to select a date for the Daily Status report.  (Same as double clicking on Entry Date label or 
clicking on icons.) 

 Click on High Limits Summary to see a summary table of the non-overlapping 30 consecutive 
day periods referred to in CARs 720.15 and 720.16 for extending the limitations to flight time and 
flight duty time.  The dates of the 30 consecutive day periods will be shown with the dates on 
which the high limit option was used.  Count the number of periods.  If there are less than 6 in the 
previous 365 days, then the high limits are available on the entry date.  If there is a 6th block 
currently in use (the end date of the block is after the entry date), then the use is allowed on the 
entry date.  (No duplicate control on the screen.) 

 Click on Violation Summary to check any number of pilot records over any period of time for 
existing CARs violations.  Enter a range of dates and select any number of your pilot names.  
Click Enter and each pilot record will be opened and scanned for any violations.  A Table will be 
created which can be printed as a summary.  This operation will take some time.  To reduce the 
calculation time, uncheck Auto Calculate in View > Auto Calculate (ON for faster PC’s)  You can 
minimize the FLTDUTY window and work on other applications during this potentially extended 
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operation, even if your mouse icon shows the hourglass.  Click Minimize in the upper right corner.  
Do not do any other operations in FLTDUTY while these calculations are being made. (No 
duplicate control on the screen.) 

 Click on Pilot Record Update Summary to check the date of the last recorded information, the 
total number of days in the record and the current total flight time in each of your pilot records.  
Select the pilot names you want to check and click OK.  A Table will be created as each pilot 
record is opened and checked for the last entry date.  This could take some time.  You can Print 
the table contents.  (No duplicate control on the screen.) 

 Click on Show Table to have the table assembly screen come up asking for range of dates for a 

table of daily calculations.  To hide the table (but not delete it) click on Show Table again.  (Same 

as Table ON/OFF command button.) 

 Click on Show Notes to have the notes screen come up.  To hide the notes (but not delete them), 

click on Show Notes again.  (Same as Notes ON/OFF command button.) 

 Click on Show Pilot Records to show the folder for recording pilot information.  Enter personal, 

licensing and training information for the pilot.  (Same as clicking Pilot Records command 
button.) 

 Click on Show Aircraft Records to show the folder for entering aircraft movements.  A database 
is built and reports can be generated based on queries and searches for levels of activity and use 

of the company fleet.  (Same as clicking Aircraft Records command button.) 

 

Options: 

 Click on Optional Parameters and a box will appear in the same area that asks for label names 
for options in the notes section.  You can keep a running total of any parameter you wish in the 
notes section.  This could be something like revenue hours, passengers flown, hectares sprayed, 
fires worked, $$$'s or whatever suits the nature of your business.  There are 4 options possible 
and you can choose what you want.  In this screen you will set the labels that appear beside the 
option entries and totals.  What you enter here will be presented for a period forward until you 
select reset.  This is referred to as a block of values.  If you are changing a label in an earlier part 
of the record where values have been previously entered, you will be asked if you want the values 
to be changed or just the labels.  Enter the label as you want it to appear in the notes section for 

any or all of the options.  Click on Done to hide the frame.  Each pilot and each block can have 
different labels but for consistency in the Daily Status Report it is better if you arrange the options 
the same for each pilot.  After you set reset no earlier value will be considered in the current total 
but the label will remain until you change it here again. 
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 Click on Printout Options to see a list of available columns that can be included in the printed 
report.  There is not enough room for all the columns to be printed, even in landscape paper 
orientation and small font size.  You should select those columns that you think will be the most 
valuable for your hard copy record.   

You can enter column header text for the Optional Parameters columns that may be a better fit 
than the original Optional Parameters name (use contractions and abbreviations).  If you make an 
entry in the header text box, this will over ride any name entries in the Optional Parameters and 
will apply to all pilots all the time.  If you have changed Optional Parameter names or have 
different optional parameters for some pilots, leave these boxes blank and the original names will 
appear (possibly truncated for space) in the headers.  For multi-pilot reports, a generic header will 
be used. 

There is a default selection that will appear if you click on Return to Default or when you initially 
load the program.  Your own selections will be preserved, if you make changes, session to 
session and record to record. 

Check Print Summary Information to have the totals for the period for flight time, flight duty time 
and your optional parameters (if any) shown at the end of the report tables and in the printouts. 

Select one of the Font Size options for your printer font.  The larger the font, the more space the 
columns will take up.  For more columns, you can select landscape paper orientation and for even 
more room, select a smaller font size. 

 Click to check No Ops Spec 091, 092, 093 if your operation does not include these Ops Specs 
which allow the use of the alternatives offered in the Standards.  Predicted limits will be based on 
the Regulations only and will be more restrictive.  Same as checking the option on the main 
screen start up window. 

 Click to check 24 hour clock entry format to have your entries in Report, Released and On Call 
entry boxes default to a 24 hour clock (08:00, 22:00) rather than the AM/PM format.  Use local 
base times consistently no matter what time zone the pilot starts in, travels through or ends up in.  
Make long term adjustments during a rest period significantly longer than the minimum required.  
Do not use UTC. 

 Click on Warnings to see the limits set for when the yellow background flags will come up.  You 
can change from the default settings of 7 days before a mandatory day off and 10 hours before an 
accumulated flight time total and 30 days before an exam or check ride, in whole numbers. 

 Click on Security to see the security features page.  Activate the security features by clicking on 

Activate Security Features.  With security ON, the program will open with a login screen that will 
require a user to enter a password.  Users can be set up with passwords and clearance levels that 
will allow different capabilities within the program.  Users with Administrative level clearance can 
de-activate the security features to eliminate the password requirement. 

 

Help:   

 Click on Contents to see the FLTDUTY XLS 2.06 Help File.  Use the Contents page like a table 
of contents.  Use the Index and Find pages to look up a particular topic. 

 Search same as Contents. 

 Click on CARs Reference if there is a violation noted in the CARs Violations section and a 
message box will appear with a reference to the specific regulation by number.  If there is no 
violation shown you will hear a Beep.  (Same as double clicking on the line of text in the CARs 
Violations box.) 

 Click on CARs Text and a copy of the Canadian Aviation Regulations Part VII, Division II or Part 
VI, Subpart 4, Division IV associated with this program will appear over Section 2 with a scroll bar 
so you can read the regulations and standards this program considers. Use the key word search 
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feature to find specific rules.  To hide the CARs text click on CARs Text again.  (Same as CARs 

ON/OFF command button.) 

 Click on Upgrade/Conversion to make any older version pilot record correctly formatted for the 

current version of FLTDUTY.  Select the old file and click Convert to make the amendment at the 
source.  Import in the normal way once the upgrade is complete.  (No duplicate control on the 
screen.) 

 About FLTDUTY...  Has the serial number for your copy of this program and other information.  
(Click on the logo at the bottom of the Command Button section to see your serial number under 
CARs Violations in Section 2.) 

THE FLIGHT TIME DETAILS SCREEN (PLUS Edition Only) 

 
 
When you make an entry in the Flight Time box, a window will pop up which allows you to enter 
some detail on the flight time.  You can associate the flight with a type or types of aircraft so that 
total flight time on types will be recorded for this record and appear in the reports generated by the 
Pilot Records section and show in the Tables.  You can also designate some recurrency or recency 
items that can be tracked and associated with the flight time (like night take-offs and landings, or 
IFR approaches or time in IMC).  Warnings will appear if you are coming close to the end of the 
cycle for these recency items and the Next Due for each will be tracked. 

When the window appears after a flight time entry (or change), select or enter the type of aircraft 
designator in the text box.  If the type does not appear on the list, you can type in the designator 
and click Add to have the list updated.  If you want to clear a type designator from the list, select it 
and click Remove.  If you flew more than a single type during the duty period, enter the portion of 
the total flight time for the second type and select or type it in the second box.  The top box label will 
reflect the split flight time and the 2 types will be associated with the duty period for display and 
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reports.  A third type can also be entered with another portion.  Click OK to return to the main entry 
screen.  The associations will be displayed beside the Flight Time box 

Click on the Setup Recurrent page to set up your recurrency and recency items (up to 6 different 
possibilities). 

In the top Section 1. Pilot, you click to check the recurrency items you have created that apply to 
this pilot from the entry date onward.  Not all pilots all the time will have the full set applicable.  If 
you have the item checked in the top section, then the warnings and next due dates will be 
displayed.  You will be able to enter the recency items as they occur on the Logbook page for each 
duty period. 

 

To set up the recurrent items you want to track, enter the validity period along with a description and 
Code in Section 2. Recurrent.  Click on the Set button for each item to set up and then click again 
to store.  In the example for Set 1, click Set 1 to make the boxes appear; enter “Night Take Off’s 
and Landings” in the Description box; enter “5” in the Limit box and select “times” from the drop 
down list; enter “6” in the validity box and select “months” in the drop down list; enter a code (for 
easy display) “Night Flight” in the code box.  Click Set 1 to store.  Your first recurrency item is now 
set to be “Night Take Off’s and Landings 5 times in 6 months.”  Click Set 2 and enter another 
description, limit, validity and code then click Set 2 again to store.  All of your pilots will be the same 
for these items so set what you want to track for all pilots and then choose which are relevant at 
what times for the individual pilot in section 1. Pilot.  The label will reflect your choices and the 
Logbook page will be updated. 

On the main screen, you will see a small airplane icon appear above the Flight Time box 

when you are approaching a recurrency limit as a warning.  You can double click on this 
icon to have the Flight Time Detail window appear with more information. You will see the 
actual limit and time remaining on the Logbook page with yellow for warning and red for 
expired items. 
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The entries you make on the Logbook page will display on the main screen as text beside the Flight 
Time box on each duty day that there was flight time or recurrency items logged. 

 

THE MULTI-PILOT STARTUP SCREEN 

If you are using the program for more than one pilot, another screen will appear over Section 1 

when you first start up the program or when you select Open or New from File on the menu bar.  
This frame offers the list of pilots by name in alphabetical order to select for starting.  You select a 
pilot name by selecting the Pilot Name option and clicking on the name in the list box and it will 
become highlighted.  To open that file, double click.  Or, once you have selected the name, click on 

Open and the program will start.  Select the Groups option (when you have created pilot groupings) 
to see the list of groups.  You can select one or more groups to have a shared entry automatically 

added to each pilot’s record.  Click on Open and make the common entry, then click OK. 

To delete a file permanently, select the offender and click on Delete.  It will be erased without a 

trace.  There is no Recycle Bin here...  To leave the program from this point, click on Exit or Exit 

from the File menu bar. 

To add a new pilot to your list and create a file, click on New.  A yellow shaded frame will appear 
with a box to name your new file and select a start date for the record.  Once you are satisfied with 

your entries, click on Add and the new name will be added to the list and the record will be started 
for you to make the initial entries. 

Also on this screen, to the left, is the choice to set Auto Calculate now which is presented as you 
have set it previously and can be changed now, or at any time from within the program from the 

menu bar View list. 
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DAILY STATUS REPORT 

There is a command button on the multi-pilot screen to allow 
you to create a table of calculations for any particular date for 
any number of your pilots.  This is referred to as a Daily 
Status report and represents a summary of your flight crew 
status on a daily basis.  From the multi-pilot screen click on 

Daily Status Report and the screen will change. 

 

To make the table: 

 Enter a date.  The default date is today's date but you can enter any date by typing over the 
default.  Click on the calendar icon to have the pop up calendar appear to help select a date.  If 
the selected date is not within the record period for any of the selected pilots, the program will 
leave the entries in the table blank.   

 Select either Pilot Names or Groups to be displayed.  To arrange your pilots into groups, click 

on Edit Groups.  From the list of pilot names or groups, select those you want included in the 
table by clicking on them to highlight.  Deselect by repeating the click.   You can shortcut to 

select all using the Select All button. 

 Once you have a date and all names you want selected, click on Show Table to start the 
calculations.  This takes about the same time as opening a file and doing a single calculation 
times the number of pilots in your table.  The table will be presented in Section 2 with most of 
the calculations done on each day in the columns.  Scroll bars on the right side and bottom will 
move the table into view if it does not fit on the screen completely.   
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 If any of the pilots show a Warning or a Violation on the date you have selected, an Advisory 
window will appear listing the names.  You can print the advisory for future reference.  Click 

Cancel (or press Esc or click close window “X”) to close the window. 

 To print the table, click on Print Table from File in the main menu bar.  Use Options > 

Printout Options to arrange columns and fonts as desired.   

 To clear the table from view, click on Return to Main.   

This table can only be set up from the startup screen.  From the main program, if you want a Daily 

Status Report, close your current pilot file by clicking on File in the menu bar then Close (or Open).  
This will present the startup screen with the option for the report. 

GROUPS 

 
You can create Groups and then add pilots from the list of pilot names.  This might be the crew of a 
particular aircraft who would share the same schedule or perhaps all the pilots on a particular base 
who might sometimes share a common schedule.  You can add a single pilot to any number of 
groupings so arrange your groupings to suit your operation and minimize repetition for daily entries.  
Make the names descriptive so you’ll recognize them in the list.  Use this feature when you want a 
report on a specific group of pilots in Daily Status Report or when you want to make a common 
entry to avoid repeating entries for pilots who share the same schedule. 

Click Edit > Edit Groups.  A form will appear that shows all your pilot names in a list on the left, 
and a text box with a drop down list that shows your group names with the pilots in each group 
listed below.   

To add a new group to your drop down list, click on Add Group and enter the new group name in 

the text box on the right; select pilot names from the list on the left and click Add>> to have them 
added to the group.  Your pilot names can be listed in alphabetical order or in the order that you 
select them.  Choose the option that you prefer.  Continue creating the list of pilot names until your 
group is complete, then click on Save Group to permanently save the group name and list.  To 
remove a pilot name from the list, select the name in the right hand list box and click on 

<<Remove.  
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To make changes to a previously entered group, click on the down arrow and select the group.  
Click on the pilot names and either add or remove as desired.   

To remove an entire group, click on Remove Group and the group name and all the pilot names in 
the group will be erased.  This does not affect the records, just the user defined groupings for the 
Daily Status Reports and Group Entries.   

Close the edit groups form by clicking on the close window X in the upper right corner (or press 
Esc).  If you select Groups to be displayed, you will now see the group names that you have made 
rather than the pilot names. 

SECURITY 

The program can be set up to require a password to open.  Users must be registered and given a 
password (which they can change to better suit at any time) and a security clearance level (which 
allows various restricted access to the program features).  This feature is optional and can be 
activated or de-activated at any time. 

Administrative Level Features:  Some users (at least one user) can be given Administrative level 
clearance.  At this level, all the program features are available including adding users with 
passwords, deleting users and passwords and making changes to the security features.   To 

access the security features window, click on Options in the main menu bar > click on Security.  A 
window will appear that allows setup and changes.   

To add user names to the list of recognized users, click on Register New Users (the default).  
Enter a user name in the text box.  If you are anticipating setting up a Single Pilot user with access 

only to his own record, then click to check Single Pilot in the Clearance Level frame and a list of all 
pilots will be presented.  Select a name from the list to avoid spelling differences between the user 
name with password and the pilot file name.  These must be identical to open the specific pilot file 
after login.  For other users, enter the user name; then select one of the clearance level options; 

then enter a password.  Click OK (or press Enter).  You will need to repeat the password to confirm 

the spelling in the yellow shaded box.  Click OK (or press Enter) again and the 
user/password/clearance level combination will be registered and recognized on login.  

To see a list of all registered users, click Show List.  To hide the list and continue editing, click 

Hide List (or Cancel). 

To make changes to existing users’ passwords and clearance levels, click on Make Changes.   A 
list of all the users will appear; select from the list by clicking to highlight (or scroll with up/down 

arrow keys); click OK.  Make your changes to the password or clearance level and click OK. 
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To remove a user from the list, click on Remove User.  The list of recognized users will appear; 

select from the list by clicking to highlight (or scroll with up/down arrow keys); click OK. 

You can activate or de-activate the security features option by clicking on Activate Security 

Features / De-activate Security Features.  A message box will appear and the next time the 
program is opened the option will be in place. 

Operational Level Features:  Users with this level clearance will have access to all program 
features except Delete pilot record files and they cannot make changes to security features.  At this 

level, change password by clicking Options > Security > then enter a new password, confirm by 

repeating and click OK. 

Single Pilot Level Features:  Users at this level must have an identical user name and pilot name.  
This will provide access to only their own pilot file.  They can make entries in their own file and use 
the program features as a single user.  They will not be able to access to read or alter any other 

pilot record.  Change passwords by clicking Options > Security > then enter a new password, 

confirm by repeating and click OK. 

Read Only Level Features:  Users with this level clearance can access all program features and 
all files but cannot make entries or alter the files permanently.   Change password by clicking 

Options > Security > then enter a new password, confirm by repeating and click OK. 

PILOT PROFILE 

Click Pilot Records and enter pilot information in this section.  You can keep track of Personal 
information like address, home telephone, next of kin, emergency telephone number and notes.  
Enter a first name and last name here if the boxes are visible for doing this.  After these boxes have 
been filled in, you will see the name as used in the rest of the program.  The first and last names 
are used to sort some lists by surname in other program areas.  If you don’t fill in last names for 
some of your pilots, the alphabetizing in lists of pilots will be incomplete, however, all pilot names 
will be on the lists - just not ordered.  To change the spelling or format of the first and last names, 
double click on the Name:* label to have the option boxes re-appear. 

Under the Licensing tab there is space to note recurrency requirements like medicals, instrument 
check rides and PPC’s.  If you have entered a Date of Birth in the Personal Section, a default date 
for the due date for the next medical will be offered - 6 months for 40+ age and 12 months for <40 
age.  IFR check rides will have 24 month (1st day of 25th month) defaults offered for next due date 
and the same option will appear for PPC’s.  For PPC’s (up to 4 different types), enter the type of 
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aircraft, then the date of the PPC check ride - the next due date will be offered as a default.  If this 
is an initial PPC and the validity is for only 6 months, you can highlight and type over the default to 
enter the correct date.  Any default can be deleted and replaced normally.  

Under Training information, enter the dates of initial and recurrency exams for aircraft, company 
operations and Transport Canada requirements.  There are boxes for up to 4 sets of exams and 
ground training that should correspond with the PPC entries.  The labels will show the types entered 
under PPC’s.  If you have tests and training for non-PPC’d types, you can enter a type in the PPC 
type column in Licensing without any dates and the labels in Training will show the types.  You have 
two options for entering dates under recurrent training.  (1) You can record the date on which 
exams and tests were completed.  The due dates can be seen by holding the mouse cursor over 
the date box and the pop up window will display the “Next due by...” date.  When today’s date 
approaches the due date, the background colour of the date box will change to yellow within the 
warning period and then red when overdue.  (2) You can enter the due dates for the current set of 
tests and ground training in the date box as a future date.  The mouse cursor will cause the pop up 
window to appear with the second next due date showing.  The background colour of the date box 
will change to yellow when today’s date approaches the due date as presented.  If you use this 
method, the Search features in Print 2 tab will not find your 30, 60, 90-day due dates unless you 
enter a reference date 1 year in advance. 

There are 6 boxes for other recurrent exams.  The default labels show Dangerous Goods, Surface 
Contamination, Ops Manual, and First Aid but if you want to change these, just double click on the 
default label and enter what you want.  All pilot records will reflect the changes to the labels you 
make here.  If you enter a label in one of the Option spots, this will be unique to the particular pilot 
record that is open.  You will need to enter the Option label in each pilot record to have it 
customized.  All the dates in this section will all show 13 month validity period. 

If you want to show a category that has a validity period longer than 1 year (13 months) like High 
Altitude Indoctrination Training or First Aid, you can double click on the Label text and enter new 
text that includes the word ‘Next’ or the word ‘due’.  (Like “Next HAIT:” or “First Aid due:”)  Enter the 
date for the end of the validity period as a future date.  The Next due by … date when you hold the 
mouse over the box will be the date you have entered and the reports will select the next due date 
as entered.  Warning colour changes will occur on time as you approach the due dates.  

Flight Times can be entered as of a particular point in time (such as at the hiring date, or annually 
updated) and are not automatically updated by FLTDUTY XLS but can be amended manually as 

appropriate.  The exception to this is the Total Calculated Flight Time at the bottom of Flight 
Times(1).   This entry can be set as of any date within the pilot record period and then FLTDUTY 
XLS will automatically add Flight Time entries to the total for a current running total.  To set initially 
or reset the total, as an update in case your pilot record does not include all flying such as might 

happen in seasonal work, click on Reset.  A new frame will appear for you to enter the date and 

total flight time that is correct.   Click on Set and the new updated total will be used and calculations 
made from that point forward from FLTDUTY XLS entries. 

You can create your own labels for the section under Other.  If you want all your pilot records to 

reflect the same label, use the top row in the Other section.  Double click on the label text 
(Helicopter, Seaplane, XCountry, Instructor) and type your preferred heading into the box.  The 
label will be changed here and for all your pilots.  To establish a custom or unique label for a single 
pilot, click on the “Option #” label in this and the other sections and it will highlight.  You can type in 
this spot and the new text will be saved.  If you want the same header for other pilots, you will need 
to enter the Option # change in each record.  Only date information can be entered here. 

Background colour will change to yellow within the warning period (default 30 days but you can set 

by clicking Options > Warnings) and red when appointments for exams or check rides are 
overdue. 

Dates are always displayed like Jan 1, 2000. 

There are 2 tabs for print information.  In Print 1, each pilot is separate.  Select one or as many of 
the pilot names as you want from the list, then select the specific areas from within the Tab sheet 
sections that you want.  Check Separate Pages if you want each pilot to have a separate full page 
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report and click Print.  You can print as little or as much of the information as you’d like to make the 

reports more specific.  In Print 2, you can have the entire record searched for due dates and the 
report will show these in order from the earliest to the latest.  You can restrict the period.  For 
example, you can have all the medicals due within the next 30, 60 or 90 days for your pilot staff.  If 
you have entered hire dates in the Training section, you can get a pilot seniority list here.  If you 
have the same hire date for a number of pilots, you can enter a Lottery # and set the order for 
seniority within the same date – lowest number is more senior. 

In the database version of the program, you can preview the reports prior to printing - click Show. 

 

Expanded Features (PLUS edition) 

In the PLUS edition of FLTDUTY XLS, there are expanded features in the Pilot Records Section 
(expanded from 150 to 400 user inputs).  This edition contains entry boxes for all of the original 
information plus an expanded Initial Training, Recurrent Training and Licensing sections as well as 
additional Personal information spaces.  There are boxes for Initial training on 10 aircraft types 
(from only 1 type in the standard edition).  There is Recurrent Training for 16 different items (from 6 
in the standard edition) and under Licensing there is room for up to 7 different aircraft types (4 in 
the standard edition) and 15 different list items associated with each type (6 in the standard edition 
not type specific).  Some of the training requirements able to be displayed and tracked include 
medicals, IFR, Dangerous Goods, First Aid, Surface Contamination, WHMIS, CFIT, High Altitude, 
CRM, Fire Fighting, PPC, PCC, right seat conversion, aircraft servicing, route checks, MEL, RVR 
1200 checks as well as the original flight training, ground training and exams.  All of these can be 
changed as needed and additional empty spaces are provided for customization. 

The PLUS edition features expanded lists for tracking training and personnel record items.  These 
are usually paired in columns for entering “Last …” and “Next…”.  Validity periods can be set from 6 
months to 5 years as anniversary dates or due on the 1

st
 day of the next month.  Each can be 

renewed within 90 days of the due date and have the same extension as if done on the due date, or 
not.  All items in the lists will be consistent for all pilots.  (There are no unique labels in this edition.)   

All due dates are visible at all times (does not require the mouse to be held over to view the due 
date) and warning colour changes appear as set by the Warning settings.  You do not need to 
include the word “Next” or “due” in the labels for due dates.  All due dates are displayed in the right 
column and reports are generated using the dates only. 

Almost all the labels set by default for the lists can be customized to anything the user wants and 
may be specific to your particular operation.  These are set in pairs for Last and Next which usually 
is automatically filled in.  To change any label, double click on the text.  A new window will appear 
with the old label highlighted.  Type in any new label for items in the list and click OK.  If you are 
modifying the left hand column, the corresponding Next pair on the right hand side will also be 
modified.  Leaving a blank in the box will bring back the existing label by default. 

PERSONAL 

There are extra boxes for entering dates for qualifications and status changes for each pilot.   The 
default list has 6 paired boxes which could be used for check outs for First Officer and Captain for 
up to 6 of the company aircraft types, but these can be changed and grouped any way you’d like..  
There are 4 options which can be entered as non-dates – like email address, cell phone.  There are 
also 5 options to enter non-training type due dates – like passports, drug tests.  Some labels can be 
customized.  Hold your mouse arrow over the label to see if the Double Click text appears or test by 
double clicking.  Validity periods can be customized and 90 day renewal can be set. 

LICENSING 

There is a sub folder with 7 lists for up to 7 aircraft types.  These are identical to start with but you 
can change any to customize.  To set the aircraft type, place your mouse in the space that says 
“Enter company aircraft type here.” And click.  The text will highlight.  Type in your aircraft type for 
Type 01 – like PA-31 Piper Navaho or CV580 Convair.  This will appear across the top of the page, 
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the tab will change to a short version and other lists will display the new type.  Repeat for each of 
the Type pages for your fleet of aircraft.   

Enter things here in the Last/Next list that are on a recurring basis and are type specific.  This can 
include PPC, PCC, Flight Training, Right Seat Conversion, Ground School, A/C Exam, Emergency 
Procedures, A/C Servicing, Route Check, RVR1200, MEL and others.  All labels can be customized 
in pairs.  Each Type page can have a different list.  All validity periods and renewal options can be 
set initially or changed at any time.  (Double click on the validity period text and make changes by 
selecting from the list of options and check or blank the “same as 90 day” option box.)    

RECURRENT 

There are the original recurrent items here like medicals (with validity set by birth date in Personal 
page) and IFR but all the other labels can be customized by double clicking.  All the validity periods, 
including medical default and IFR, can be changed or set at any time.  Enter items here that are 
general and not aircraft type specific.  These can be things like Dangerous Goods, First Aid, 
Surface Contamination, WHMIS, CFIT, High Altitude, CRM, Fire Fighting and others. 

There are 3 items at the bottom of the Recurrent page that do not follow the convention of double 
clicking and entering the new label.  These labels can be changed by single clicking on the text.  
You will see “Enter new label here.” text highlighted.  Type over this and insert your new label.  This 
will set the new label here and for all pilots and otherwise be the same as the upper list. 

FLIGHT TIMES 

If you are making aircraft type associations with your flight time using the Flight Times Detail 
screen, you will see your total accumulated flight times on types in the second Flight Times page.  
There is an archive second page here for Setup Previous Experience where you can enter previous 
flight time on types that is not included in the duty time record – before Day 1- for a current time on 
types total.  Click on the Setup page and enter types exactly as you have them entered elsewhere 

with a flight time total as of the start of your record (or the first day you started keeping aircraft 
flown records with your duty time).  Enter the time on type from before the record.  Click back to the 
Experience on Aircraft Types page and click Recalculate.  Any duplicate entries by type from 
archive in setup and the flight time record will be totaled for display in the table. 

INITIAL 

There is space here for 4 items that occur at initial hire only – like Company Indoctrination, banking 
information, insurance sign on, or any other training or record you do initially.  There are spaces for 
initial training record for up to 10 company aircraft types and these will be preserved as you do 
them.  You can come back here and do an initial type check record as the pilot moves to more 
types within the company. 

Reports 

The original reports have been expanded to include the new items.  There is also a new set of 
reports based on each aircraft type in Print 2. 
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For information on updating to include the expanded Pilot Records feature, contact the 
vendor. 

 
Eric Bradley 

453 Waterloo row 
Fredericton, NB  

E3B 1Z6 
 

(506)455-8176 
castleb@nbnet.nb.ca 
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IMPORT/EXPORT FILES 

You can cut copy and paste the pilot record files by using Windows My Computer or Explorer or you 
can use the features within the program for maintenance. 

The internal features are: 

For file delete, you can select the pilot name from the list on the multi-pilot startup screen and click 

Delete button.  There is no Recycle Bin so after the prompt (Are You Sure?) the record will be 
permanently erased. 

To create a copy of a pilot record on a flash drive, click the BackUp button on the main screen in 
the Command Button section when you have that record open.  To backup any or all of your pilot 

records, click on File > Complete BackUp and select all and check to “Include Profile information” 
and “Include Label text” to have the complete list and all data and formatting backed up 
automatically. 

To transfer pilot records from one copy of the program to another, click on File > Import/Export 

and select either Import Pilot File or Export Pilot File.  You can send a copy of a pilot record to a 
flash drive or delete the record from the original program and store it on a flash drive for transfer 
out.  You can add a record to your list from a copy on a flash drive and either copy it and save the 
backup on the flash or remove it from the flash and add it to the second copy of the program.  
Check to include pilot profile information and a separate file will be added to the Profiles section. 

Export Files 

Click File > File Import/Export > Export Pilot File to bring up the form.  Check Include Profile 

Information if you want the personal data to be transferred also.  Select the pilot name from the list 
on the left and then select a drive (usually the flash drive) and a folder (usually the root directory) 

and click either Move or Copy.   

To keep a record on the original program, click Copy.  A copy of the pilot record file will be made on 
the flash drive and the original program will maintain the original record.  This can be used if you 
expect the pilot to return at some point to the original computer or if 2 copies of a pilot’s record are 

to be maintained.  This is like clicking on BackUp.   

If the transfer is permanent and you don’t expect the pilot to return, then use Move and the pilot file 

will only appear on the flash.  This is like clicking on Delete after a backup has been made.  The 

Pilot Records will be lost unless you also check Include Profile Information.  The pilot profile data 
is copied to a separate folder on the destination disk (Profiles) and a small file is created 
(PilotProfiles.txt) which contains the personal information and can be imported along with the flight 
duty time record.  (See below.) 

Import Files 

Click File > File Import/Export > Import Pilot File to bring up the form.  Select the source drive 
(usually importing from a flash drive) and a folder (usually the root directory) and then select the 

pilot name from the list.  Click on either Move or Copy. 

To keep a copy of the file as a backup, use Copy and the record will be added to the program and 
the pilot name added to the lists while preserving the file on the flash.  If you just want to make a 

clean transfer to the new computer, use Move and there will only be one record. 

If you have included the pilot Profile information during the Export, you can check Include Profile 

Information here and the data will be brought in and included with the other pilot records.  There 
will be a separate folder called Profiles on the source disk and a small file called PilotProfiles.txt that 
includes the copied profile data.  This file will remain on the disk unless all pilot record files have 
been moved rather than copied. 
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The program will warn you if there is a file of the same name already on the list.  If you want to 
import and overwrite, then click 

Yes at the prompt.  Overwriting 
means that the copy coming in 
from the flash will be preserved 
and the copy on the computer 
will be lost.  Be sure the 
imported copy is complete.  If 
you’re not sure, make a backup 
of the copy on the computer 
before making the import in 
case there have been changes 
on one and not the other.  
Importing is overwriting not 
merging. 

Update records 

If you are using the program with multiple copies in the field and a master copy at head office, you 
may want to export files for your pilots to keep up when they are away from home base and then 
import these back upon their return.  If you have concerns about overwriting existing records when 
a Move or Copy command is done, you can protect your earlier records and choose to update the 
master copy by updating rather than doing a total import from the other copy. 

To do an update, rather than a complete overwrite, select the pilot file from the import source (flash) 

and click on Update.  Enter the range of dates that you wish to be imported from the copy and 

inserted into the master record on your computer.  Click OK and the imported file will be read, the 
records for only those dates that you have selected will be copied into your record in FLTDUTY XLS 
and all other entries will remain untouched. 

NOTE:  You can use this method to import completely different files from any other copy of 
FLTDUTY.  If a pilot had an original record, or started one on his own, you can amend your copy of 
his file by selecting the dates.  As long as the dates are included in the imported record, you can 
have them added to yours.  Any gaps will be inserted as days off.   

(With a little creative file shuffling, this is one way to add records before Day 1… Move the pilot file 
onto a flash drive; create another file of the same name with the start date farther back; Import the 
original file back as an update selecting all the dates that had entries to be added.)  

 

Or you can use standard Windows features: 

For manual transfers, the records are in C:\FLTDUTY XLS\Pilots and can be recognized by the pilot 
name filename and the .txt extension.  To remove a pilot from the list, you can delete or move his 
file from the folder.  To take a pilot’s record from one copy of FLTDUTY XLS to another on a 
different computer, just copy the Pilot Name.txt file to a flash and then copy it into the new 
C:\FLTDUTY XLS\Pilots folder.  To transfer pilot profile information manually (not possible in 
database version), you must open the PilotProfiles.txt file in FLTDUTY XLS\Profiles folder.  
Highlight to select the line with the pilot name you are moving and cut and paste it to the new 
Profiles\PilotProfiles.txt file in the other computer.  Each pilot has one long line of information, 
separated by commas, so be sure that you select the entire line after the pilot’s name.  Include 
everything on the same line as the pilot’s name as well as everything on the next line if it doesn’t 
start with another pilot’s name.  (The lines are so long that Notepad needs to wrap them to fit on 
screen.) 

Transfer Label Text and Format  
If you are using separate copies of FLTDUTY in different computers at different locations, you will 
want the formatting and order of all the optional labels to be identical in each copy.  The label text 
settings are saved in each copy of Windows. To transfer from the master or original copy of the 
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program, you can use the Export/Import features and check to “Include text from Labels” while 
transferring pilot records or updating. 

When you have a new copy of FLTDUTY in a new computer, use the Export feature to copy pilot 
records from the original.  To have the new computer set up with the same labels in the Pilot 
Records section (like PPC’s, recurrent training exams, MEL, CFIT, Human Resource training, initial 
check out exams or checks…) make sure you check the box to “Include text from Labels” during an 
initial transfer.  A small file will be created on the Export destination in the Profiles folder.  Use this 
disk or storage device to Import the records into the new computer.  Check “Include text from 
Labels” during import to the new computer and all the custom labels will be transferred as well as 
the specific pilot record information.  All copies of FLTDUTY should have identical custom labels so 
reports are consistant.   

You only need to do this once to transfer label text unless you change custom labels and want to 
make changes on all copies on all computers. 

 

UPGRADE/CONVERSION 

In the course of the development of this program, the format for the data storage has changed as 
more features were added.  Pilot record files created by early versions of the program cannot be 
read immediately by the current version.  The conversion procedure need only be done once.  Once 
a file is converted, however, there is no facility for returning to the original format. 

If you have made an upgrade to FLTDUTY, it is important that you upgrade all copies of your 
program.  When you first install the new version, all pilot records currently in use will be 
automatically converted (you will see a message as this is happening).  If you have other records 
stored elsewhere, like backup files, when you import these to the new version, you will be reminded 
that conversion is required and will be directed to the screen. 

In the main menu bar under Help, click on Upgrade/Conversion to convert pilot records from early 
versions of FLTDUTY to the current version.   

Select the file name (Pilot Name.txt) and click Convert and the update will be completed at the 
source.  If the file is already in the FLTDUTY XLS\Pilots folder (manually copied in rather than 
Imported using the program features), you should see the offender in the file list box.  If the file is on 
a flash and being imported, you should also see it and the contents of the flash in the file list box.  If 
you do not see the file you want to convert.  Use the drive and directory lists to select your file.  If 

you have trouble finding the FLTDUTY folder (C:\FLTDUTY XLS\Pilots), click on Find? and the 
folder will be automatically shown with all your current pilot names in the file list box. 

If the old file is on a flash, it will be amended on the flash.  Then you can import it into the FLTDUTY 
program the usual way.  Be sure there is room on the flash for a larger upgraded file.  The new files 
are 25% larger than the old files. 
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WHAT IT ALL MEANS 

WARNINGS 

The real value of this program is that it not 
only creates a record of your flight duty 
times and flight times, but it will offer 
warnings as a limit defined by the CARs is 
approached.  It will also note any violations 
that incur as a result of ignoring these 
warnings, which may or may not be a good 
thing... 

The warnings and violations appear in 
different places on the main screen but in general are marked by (1) Changes in background 
colour; (2) Warning labels on the right side of Section 1; and (3) Message boxes that appear over 
the main screen and require an 
acknowledgment.  Yellow colour means 
WARNING - A LIMIT IS APPROACHING.  
Red colour means VIOLATION. Other 
labels may simply mark a specific event 
such as a Day Off as defined by the CARs 
(24 consecutive hours free from flight 
duty), or a Split Duty Day (characterized by 
reduced rest overnight and a midday rest 
period between flight duty periods in an 
aerial application operation).  

 

A violation will always be accompanied by an explanation and a reference to the specific CARs will 

come up if you double click.  Click CARs ON to read the specific regulation or standard. 
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You can set the warning period by clicking on 

Options > Warnings.  The default is set for 7 
days prior to a potential violation for rest and for 
when the accumulated flight time is less than 10 
hours from a limit and 30 days before an 
appointment. 

 

 

 

Table of Warning Labels and Background Shading 

WARNING AS IT 

APPEARS IN 

SECTION 1 

 

WHAT CAUSES THE WARNING TO 

COME UP 

 

HOW THE WARNING IS 

PRESENTED IN SECTION 2 

TOMORROW OFF! This warning comes up when the 
days to go reaches 1.   
 
It also comes up when flight time 
limits have been exceeded and you 
need to have days without flight time 
to get the total reduced to within the 
limit. 
 
See Note. 

Days To Go background colour is 
yellow and printing is red. 
 
Flight Time Accumulated Total in 
specific period background colour is 
red.  

FLIGHT TIME LIMITS This warning comes up with a yellow 
background and black print when any 
accumulated flight time total is within 
10 hours of a limit.   
 
The background changes to red and 
the printing to white when any flight 
time total is over the limit. 

Accumulated Flight Time values 
background colour will be yellow 
 
 
 
Accumulated Flight Time values 
background colour will be red. 

SPLIT DUTY DAY This label shows for aerial 
application operations when a rest 
period is reduced below 8 hours and 
a midday rest is allowed to satisfy the 
requirements for a split duty day.  
This option is not available unless 
the pilot can show 5 days off in the 
previous 30 days. 
 
For non-aerial application operations, 
this label appears when a flight duty 
period has been extended beyond 
the normal limits but the flight duty 
period included a rest period in 
suitable accommodations. 

If the 5 days off in 30 days is the 
limiting factor in determining the next 
mandatory day off, the Days Off in 
Previous 30 Days box will have a note 
above it indicating Split and with Auto 
Calculate OFF the number “5+” 
instead of “3+” for no violation. 
 
 
A split duty day in other than aerial 
application has no later consequences 
other than required rest following the 
flight duty. 

CARs DAY OFF This label shows when there has 
been a 24 consecutive hour period 
without flight duty.  It shows for the 
entry date following 24 consecutive 
hours off even if there is a duty 
period on that date.  This date will be 
considered to be a day off for further 
calculations. 

A CARs day off usually causes the 
next mandatory day off to shift ahead 
and the days off in the previous 30 
and 90 days to increase. 
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Extension Report This label appears when the 
Unforeseen Circumstances has been 
checked and a limit has been 
exceeded but no violation occurs.  If 
you have claimed unforeseen 
circumstances pushed you over a 
limit, a report must be filed and 
Transport Canada notified.  This is a 
reminder... 

Flight Duty or Flight Time values 
background colour change to yellow. 

REST OVERDUE This warning occurs when a violation 
of time free from duty has occurred. 

TOMORROW OFF! is always also on.  
CARs Violation is shown in the bottom 
list box with description. 

DAY OFF SOON This warning appears when the Days 
To Go is less than 8 days.  

Days To Go background colour is 
yellow. 

 

Note:  Occasionally TOMORROW OFF! will come up when in fact, if you have flight duty on the next day, there will be no 
violation.  If you suspect this may be the case, select tomorrow's date and enter a flight duty period and calculate.  If no 
violation occurs, you are all right for flight duty.  The reason is that on the previous day you had a requirement in place but 
by the next day, the requirement has expired even though it was not met.  You might also have gone to a higher limit 
because of the type of flight and have some extra that wasn't available the day before.  (See DEMO FILE June 21 and 22) 

 

Table of other Warnings and Meanings in Section 2. 

WARNING MEANING 

CARs Violation red 
background, white printing 
(Section 2) 

This means a violation has occurred and there will a note in the list box 
describing it.  Double click on the description and a reference to the 
CARs will show the particulars.  For detailed description of the relevant 

CARs, click on CARs ON and look up the reference. 

Entry Errors Message Box 
(Overlay) 

Anytime you make an inappropriate entry, either in value or format, a 
message box will offer some help and offer you the chance to change 
your entry. 

Flight Duty Time label 
printing red 
(Section 2) 

This will happen when flight duty time in an aerial application split duty 
day has exceeded 14 hours as per CARs in the previous 24 consecutive 
hours.  This is different from the normal period for flight duty time in that 
this limit is defined by total flight duty time rather than longest stretch of 
uninterrupted flight duty.  The value for flight duty time may be less than 
14 hours on the date, but considering yesterday’s schedule, has 
exceeded the limit.  The CARs Violation will indicate flight duty time limits 
exceeded and the reference will be for a split duty day. 

Flight Time label printing 
red. 
(Section 1) 

This happens when flight time daily limits (24 consecutive hours) has 
been exceeded even though the time on the entry date is less than the 
limit.  It reflects the influence of the previous day’s flying.  Daily limits 
exist for single pilot IFR and flight duty time extensions.  If the entry on 
the date is over the limit, the background colour will change to red. 

Next Mandatory Day Off 
date printing red 
(Section 2) 

This happens when you go past a mandatory day off without taking the 
break.  The CARs Violation box will describe the violation, REST 
OVERDUE and TOMORROW OFF! will also be visible and Days to Go 
will show less than 1 or ”-?”.  

Report for Duty entry 
background red 
(Section 1) 

This will happen when the required rest period overnight on a split duty 
day does not allow the required 5 hours between 2000h and 0600h as 
per CARs.  The report time is too early to allow for the required rest. 
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Tomorrow’s Flight Time 
Message Box 
(Overlay) 

If an accumulated flight time limit is approaching and less than 12 hours 
of flight time tomorrow will put you over that limit, this box appears with a 
calculation of the amount of flight time you can log tomorrow without 
going over the limit.  This number is not based on today’s value short of 
the limit but on tomorrow’s calculation before the start of the day.  You 
may be within 10 hours of a limit today and not be tomorrow, or you may 
have 5 hours to go today but more tomorrow, depending on the day’s 
flight time at the start of the accumulating period. 

 

TABLES 

High Limits Summary, Violation Summary and Pilot Record Update Summary tables can be created 

from View in the main menu bar.  In addition, there are two types of Table that can be created and 

displayed with Table ON and Daily Status Report.  Either type will appear over Section 2 when you 
create it, with scroll bars to allow you to view the entire table.  You can print these tables by clicking 

on File on the menu bar and then Print Table after you have them made and showing in Section 2.  
The format for the printed versions is similar to what you see in Section 2. If you have selected 

many columns from Options > Printout Options or the larger font sizes, your printer may need to 
be in landscape orientation for these columns to print.  You can change your printer settings before 

the print instructions go to your printer by clicking on Set/Check Printer Settings or from the main 

menu bar on the main screen under File > Printer Setup.  (Change your printer settings 

beforehand through the Windows Task Bar.  Click Start > Settings > Printers > click on your 

printer using the right mouse button and choose Properties.)  The default printout fits on portrait 
paper orientation in small font. 

In the tables: 

 Day Off column will be either Yes for a CARs day off on that date or will be a blank showing no 
CARs day off. 

 CARs column will be either OK for no CARs violations under this part for this date, or X for one or 
more violations on this date. 

 Special column shows type of operation: Private Ops, 702-703 or 704-705.  It will also show if 
special circumstances like On Call or an extension to flight duty time due to unforeseen 
circumstances has been entered. (May be truncated by space limitations.  You can drag the 
column boundary to size as you like.) 

 Notes column will show the first 20 characters (or until line shift) of Notes section for each date. 

 Flight Duty column will show the maximum stretch of consecutive hours of flight duty in effect on 
the date. 

 Flight Time column will show total flight time for the date. 

 Rest Since Last Duty column will show hours since last flight duty (minus 1 hour for overnight 
rests) or the entered actual rest period for the date. 

 Flight Time 7 Days column shows accumulated flight time total over 7 days for that date. 

 Flight Time 30 Days column will show the accumulated flight time over 30 days or since last 5 
consecutive day break, whichever is less. 

 Flight Time 42 Days column will show the accumulated flight time over 42 days or since last 5 
consecutive day break, whichever is less. 
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 Flight Time 90 Days column will show the accumulated flight time over 90 days or since last 5 
consecutive day break, whichever is less.  

 Flight Time 180 Days column will show accumulated flight time over 180 days (or to start of record 
if less than 180 days). 

 Flight Time 365 Days column will show accumulated flight time over 365 days (or to start of record 
if less than 365 days). 

 Days Off Last 30 Days column will show the number of CARs days off in the previous 30 days (or 
with Auto Calculate OFF will show the number or 3+ or 5+). 

 Days Off Last 90 Days column will show the number of CARs days off in the previous 90 days (or 
with Auto Calculate OFF will show the number or 13+). 

 Days to Go column will show number of days to go before a mandatory day off (without using the 
Extension Option). 

 Mandatory Day Off columns will show the date of the next mandatory days off if no breaks are 
taken before this date. 

 The Options columns will show the values in the Optional Parameters in the Notes section and the 
Option Total columns will show the accumulating totals between resets. 

 

Summary Report Table:  
This is a table showing all of the calculations over a range of dates for a particular pilot.  It is made 

by clicking on Table ON when you are in the main screen and have a pilot record open for entries 
or viewing.  This table is useful to get an overall picture of the record over time as opposed to a 
snapshot on a single day.  You can enter up to 5 years of the record in the range of dates.  This 
calculation takes about as long as making a single calculation times the number of days in the 
selected range.  (10 seconds to make one calculation x 20 days = 3 minutes). 

Use the pop up calendar for help in selecting dates.  Click the icon or use the main menu bar under 

View > Calendar (or press Ctrl + D). 
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Daily Status Report Table:  

This table is only available from the start up screen that appears either when you first open the 

program in a multi-pilot operation, or from the main screen menu bar, click on File > Open.  Enter a 
Date for your report (use the Calendar - click on the icon), choose either pilot names or groups to 

be shown in the list and then select from the list all those you want included.  Click on Show Table 
and the table will be presented in Section 2.  The table shows all of the calculations for each pilot on 
the date you selected.  This table is valuable for posting current status of all your pilots daily.  Print 

the table by clicking on Print Table from File in the main menu bar.  
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SCHEDULE PRINTOUT 

You can have a printout of the entries that you have made for a range of dates by clicking on File in 

the menu bar and then clicking on Print Schedule....  This will bring up a frame asking you to set a 

range of dates.  Enter the start and end dates that you are interested in and click on Print.  A very 
basic table of the dates and the Report and Released times and flight times that you have entered 
for each date will be printed.  This creates a hard copy of the data you have entered but does not do 
any calculations on the data.  This is a printout of your schedule straight from your entries.  
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TROUBLESHOOTING 

YOUR DISPLAY 

You can't see the lower sections:  Hide your taskbar by Start > Settings > Taskbar  - uncheck 
Always on Top.  

Your titles and menu bar do not look like illustrations in this manual:  You can change and 
customize your display through Control Panel.  I have made mine look more like Windows 3.1 - old 
habits...  I use larger fonts for the titles, menus and messages (8, 10 and 12 pitch fonts) and the old 
colour for title bars.  I started with Windows Standard (Large) scheme under Appearance and 
modified some.  You can suit yourself on the presentation of your windows. 

Date formatting or date error messages:  Your Regional Settings must be set to 
English(Canada) - in Windows Control Panel.  (Click Start > Settings > Control Panel > open 
language settings > select English(Canada) from the list.  Under Date your Short Date format must 
be in the order dd/MM/yy.)  French(Canada) and English(United States) cause problems and will 
not work. 

WORKING WITH THE PROGRAM 

Date Out of Range problems:  In any one session, if you are making entries into the future, the 
program will only allow 120 days ahead from today’s date.  If you reach this limit, you can force the 
program to jump ahead to allow another 120 days by closing the pilot record and re-opening it.  You 
cannot go to dates before the start date. 

Multiple entries in a single session:  If you must make entries for many days, and you have Auto 

Calculate OFF (unchecked), you can get away with not checking the calculations or saving as long 
as you are not in an extension (under the 42 days rule from the CARs) or following a 5 day break in 
Aerial Work or Air Taxi operations when the option to reset flight time totals to zero may come up.  
Any valid entries will be stored as you change dates in the Entry Date box including Notes and 

Actual Flight Duty Times and Rest Periods in Section 2.  Click on Save regularly if you want the 
new data to be permanently saved in the data file.  It can speed up your data entry time if there is 
no reason to expect you have entered a period where the extension option is used.  All calculations 
can be done whenever you return to a date entered this way, and all future calculations will take 
these entries into account. 

Keyboard Shortcuts:  Use Tab to change focus and move cursor along entry boxes and 
command buttons.  Use Enter to start calculations after date selected or flight time entered.  Enter 
will cause command buttons to be clicked if they have focus.  Shift focus to command buttons and 
text boxes with Alt + hot key (underlined letter in label).  Use up/down arrow keys to move down 
lists.  Use left/right arrow keys to move through search results in key word search of CARs text.  
Ctrl + hot key will bring down lists in main menu. Esc will close overlays. 

Long waits for calculations to complete:  To get more flexibility in moving around the record, 

leave Auto Calculate OFF (from View on the menu bar or at initial start screen when selecting a 
pilot name).  If you are still waiting too long to get calculations, you have a long record and it takes 
time for the program to run.  If this gets too annoying, especially in a record that is more than a few 
months long, you might consider starting a new record and foregoing the information calculated for 
the long periods like 180 and 365 day flight times.  Start a new record each season if your operation 
is seasonal.   

Faster computers can handle the calculations for any length of record.  The furthest back the 
program needs to look is 365 days and your calculations should never be much slower than at 
about the 90 day point. 
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Making an entry for midnight:  The program sees the notation 0000 and 2400 on any date as the 
same and doesn't know whether it is the start of the day or the end of the day.  The notation 12:00 
AM is interpreted as midnight at the start of the day.  (The notation 0000 will cause an error 
message that suggests 12:00 AM as an alternative.  Accept that.)  The notation 12:00 PM is 
interpreted as noon, so for a notation at the end of the day, the best solution is to enter 11:59 PM 
(or 2359).  The extra minute probably won't make any difference in calculations.  For a 24 hour 
entry, such as for On Call, the best report time would be 12:01 AM (0001) and released time as 
11:59 PM (2359). 

If your flight duty period overlaps midnight (graveyard shift...), enter the start time and end time 
normally on the same Entry Date. If you have made a split duty shift and the rest is less than the 
required rest (8 hours) between shifts, then enter the second part of the split on the same date as 
the first, even if it starts after midnight.  Otherwise, enter report time on the date that it actually was. 

It is not recommended to use Co-ordinated Universal Time (UTC) entries because the 
warnings for days off and required time free from duty when shown as a date will be the 
date in UTC and may actually be referring to the day before in local time. 

IF YOU NEED TO USE YOUR BACKUP FILES 

If you have had some sort of malfunction and lost data on your pilot files, you can re-install your 
backup files and recover the data since your last backup.  This should minimize any loss if you have 
been conscientious about maintaining your backup files. 

You can import your backup files using File > Import/Export > Import Pilot File on the main menu 
bar, or you can use Windows Explorer or My Computer to manually transfer files. 

Using Windows Explorer, find the directory where FLTDUTY XLS 2.06 is stored on your hard drive 
(probably in C:\FLTDUTY XLS if you used the standard SetUp).  You should see the pilot data files 
listed as "pilot name.txt" files in a separate folder called “Pilots”.  From your backup disk, using 
Explorer, find the last saved copy of the file you are having trouble with.  Highlight the file name by 

clicking on it.  Press Ctrl and drag the highlighted file to the FLTDUTY XLS\Pilots directory on your 
C: drive and drop it there.  If your corrupted file is still there, there will be a query about overwriting 
the existing file.  If that is what you want, the file will be replaced by the backup version. 

For Advanced Users: 

If you are having other problems or errors suddenly appear in a pilot record, you might try looking 
for the problem in the "pilot name.txt" file using Windows Notebook.  Make a copy of the problem 
file and store it somewhere else (in another directory or on a flash) before you start to modify the 
data file.  You may do more damage than good...  Double click on the file name and the data file will 
open.  The entries are arranged by date (#date#), line by line (one line per day plus comments from 
the notes section), separated by commas.  Find the date that causes the error and see if you can 
find what it might be.  Entries should be substantially the same format day by day.  Computers 
aren't perfect, and errors in copying and saving may creep in over time.  You can delete entries 
from the last one back to get beyond the trouble spot if your backup habits have been poor.  Do not 
delete a date in the middle of a record.  You can delete values in individual data fields if you can 
match the format between the commas.  Do not change the basic structure of the commas.  Watch 
for quotation marks ("").  Good luck! 
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GLOSSARY OF TERMS 
 
Calendar 

 

A pop up calendar is included as a program feature.  Click on the icon and 
select a date.  Click on Done and the date will be entered in the text box.  The 
calendar can be used when selecting an entry date, when picking a range of 
dates for a table or the date of the daily status report. 
 

CARs  Canadian Aviation Regulations.   
FLTDUTY XLS 2.06 is concerned with commercial operations under Part VII, 
Division II and private operations under Part VI, Subpart 4, Division IV for flight 
time, flight duty time and rest requirements. 
 

Day Off Under the CARs, a day off is described as 24 consecutive hours free from 
flight duty.  Examples:  (1) Any date on which there was no flight duty would 
be a day off.  (2) If flight duty concluded on Monday at 3:00 PM and the next 
flight duty didn’t start until after 3:00 PM on Tuesday, then Tuesday would be 
considered a day off in spite of the late flight duty.  
  

Days To Go FLTDUTY XLS 2.06 counts the days from the entry date to the next 
mandatory day off and indicates the days to go between the two dates.  When 
the days to go count reaches 1, then the entry date is the last day that can 
have scheduled flight duty without a violation.  The next day (tomorrow) must 
be scheduled with 24 consecutive hours free from flight duty before any flight 
duty.   
FLTDUTY XLS 2.06 displays the days to go and the background color 
changes to yellow when there is less than a week before a mandatory day off. 
 

Decline Extension 
Option 

On the first day going in to the extension option after failing to get 3 days off in 
the previous 30 days and more than 30 consecutive days of flight duty 
assignments, you are given the choice to use this option or not.  If you decide 
not to use the extension option, you will incur a violation of the CARs on that 
day and every day until you have regained a total of 3 days off in the previous 
30 days.  If you accept the option, you are committed to getting 5 consecutive 
days off before the end of the extension period instead of only 3 days off in the 
previous 30 days. 
If you later change your mind about declining the extension option, you can go 

back to the first day, click on Reset to void your entries (including checking 
the Decline Option box) and re-enter your schedule and flight times as they 
were but when the choice comes up again, leave the Decline Option box 
unchecked. 
 

Early recall from 
Reserve 

If a flight crew member was not able to get 8 hours rest while On Reserve 
status and was assigned to flight duty between 2200h and 0600h or was 
required to report for flight duty between 2200h and 0600h, the CARs can still 
be satisfied (720.21(1)) by restricting the flight duty time to 10 hours and 
extending the required rest following by one half the flight duty time.  
(720.21(2)) 
FLTDUTY XLS 2.06 allows early recall to be entered in the “Special” list of 
options.  The user must determine if the circumstances warrant it as an entry.  
The increased rest and restricted flight duty time will be applied. 
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Entry Errors Warning boxes will appear if an entry is not acceptable.  This could be due to 
formatting differences or impossible values.  There are two types of warnings.  
(1)  A Message Box appears with a message and an OK command button 
that requires acknowledgment (click on OK or press Enter) and then 
disappears.  (2)  An Input Box appears with a message and a space to put a 
corrected entry, with a default suggestion, and OK and Cancel buttons.  Enter 
a correct value in the Input Box space and click on OK or accept the default 
by clicking OK or Cancel the entry altogether by clicking on Cancel.  
In some circumstances an impossible entry will cause the rest of the record to 
be reset to blank automatically.  Try again. 
 

Flight Time This is flight time as defined by the CARs and is the time the pilot logs in his 
personal logbook. 
Enter this as a total flight time for the flight duty period if there have been 
multiple flights.  The total flight time cannot exceed the flight duty time except 
for recreational flying (which has no flight duty time). 
 

Groups Pilots can be arranged into convenient groupings to make common entries 
and reduce repetitive daily entries.  The groupings can be used for daily 
reports as well.  Each group must have a distinct descriptive name.  Any 
individual pilot can be assigned to any number of groups.  Common entries 
can be made for any number of groups. 
 

Max Flight Duty 
Time 

This is shown initially in Section 2: Daily Times as a calculated maximum 
period for consecutive duty hours in any 24 consecutive hour period.  The 
number that appears here is the flight duty time in consecutive hours that was 
the largest after flight duty begins on the entry date.  If there was little flight 
duty time scheduled early on the entry date, and a long period of flight duty 
time the day before, the value here could be the day before’s value or part of it 
since, over 24 consecutive hours, the earlier flight duty period was the longest. 
CARs limits for flight duty time generally are for consecutive hours of flight 
duty over 24 consecutive hours rather than total flight duty time on a particular 
date.  The exception to this is the total flight duty time over 24 consecutive 
hours set as a 14 hour limit during a split duty day in an aerial application 
operation. 
FLTDUTY XLS 2.06 offers this calculation as a maximum that occurred during 
the period of flight duty on the entry date.  If there was no flight duty on an 
entry date, there will be no flight duty time associated with that date. 
 

Midday Rest Period This value appears in Section 2: Daily Times if a split duty day has been 
entered.  During a split duty day in an aerial application operation, the gap 
between flight duty periods throughout an entry date is calculated as a 
maximum time allowed for rest to make up for reduced rest overnight.  The 
value displayed here is the time between the duty periods, or from the end of 
the last duty period until the day is over at midnight, whichever is the greatest, 
minus 1 hour for meals, hygiene and travel.  A midday rest will be indicated 
whether the flight duty period qualifies as a split duty day or not. 
FLTDUTY XLS 2.06 offers this calculation as a maximum.  The value can be 

changed to reflect actual circumstances by clicking on Change and entering 
the time.  Some impossible combinations will be disallowed.  This option is 
only available if there is more than one flight duty time entry.  If you need a 

value here and there is no place visible, click on Split to expose another set of 
flight duty time boxes and enter your flight duty period as two sessions 
surrounding the rest period. 
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Next Mandatory 
Day Off 

When there is a requirement for a specific number of days off in a defined 
period, such as three 24 consecutive hours free from flight duty within 30 
days, this means that from every date, looking back 30 days, there must be at 
least 3 periods that qualify as days off.   
The next mandatory day off is calculated, assuming no days off until that date, 
as the latest date before a day off must be scheduled.  There will be no 
violation prior to that date if there are no days off.  If that date is not given as a 
day off, after no days off from the entry date to the next mandatory day off 
date, then flight duty scheduled on that date will result in a violation. 
The next mandatory day off shifts when a day off is scheduled, when special 
circumstances change the requirements under the CARs or when flight time 
limits are exceeded and a break must be given to allow accumulated totals to 
fall below limits.  The shift ahead is not consistent and depends on the 
requirements and the previous schedule. 
FLTDUTY XLS 2.06 warns of the Next Mandatory Day Off and counts down 
towards that date.  If the next day is far off, there should be no real concern 
unless no days off are planned or possible.  If the next day is close, then a 
day off must be scheduled before the next mandatory day off or else 
scheduling flexibility is eliminated. 
 

On Call Status that involves a pilot being available for a flight with 1 hour or less 
notice, but without any specific location defined.  This time is not considered 
flight duty, but is also not considered time free from duty.  Example:  Pilot 
wearing a pager with immediate response required.    (Medevac pilots, charter 
pilots, fire suppression pilots) 
The consequence of using the On Call designation for a Subpart 2 or 3 or 
helicopter operation is a drastic reduction in the time before a mandatory day 
off.  The requirement goes from 3 days off in 30 days to 36 hours off in 7 days 
or 3 consecutive days off in 17 days.   
It is possible to avoid the On Call designation by allowing the specified 
location in the Standby status to extend to a wider range (like within town 
limits or within 20 miles of the base).  This designation involves flight duty time 
(see Standby) but the daily limits for these operations are high (generally 15 
hours) and extend beyond daylight hours in most cases. 
Check On Call box in “Special” list.   Enter as Report and Released time in the 
yellow shaded boxes that appear.  If the on call period is overlapped with a 
flight duty period, enter the Report time for the start of the on call status and 
the end time for the final release from on call status, no matter if there is 
overlap or not.  This will affect your available rest period but not your flight 
duty time. 
  

On Reserve Status that involves the pilot being available for flight duty on more than 1 hour 
notice.  Time spent on reserve is not considered flight duty time and is also 
not considered time free from duty.  Time entered here does not affect flight 
duty totals and limits but does affect the rest period.  There is required rest for 
the minimum rest period of 8 hours in every 24 consecutive hours.  Examples:  
A standby pilot who is expected to be able to report when called but is not 
required to be on site or nearby (1 hour).  A pilot who gets his assignments 
well in advance but is not on a regular schedule.  (Partime employees, 
occasional fill-ins, designated days off with a “hook”...). 
FLTDUTY XLS 2.06 records reserve time and will monitor for the required rest 
but does not automatically keep track of notice (required 10 hours prior to 
flight duty).  An early recall from reserve can be noted in the “Specials” section 
and there are limits and rest requirements that FLTDUTY XLS 2.06 will 
monitor once this designation has been made. 
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Optional 
Parameters 

Refers to the label text in the Notes section totalizers.  These parameters can 
be set by the user to indicate the specifics of the optional totals.  The label can 
be changed following a reset to zero (checking the lower right side check box) 
and reflect different options at different times.  There can be up to 4 different 
parameters being tracked at any one time. 
 

Password With the security features in place (optional), password protection and access 
restrictions can be implemented.  Passwords can be any length and any 
character and are shielded on entry.  Entering the password is not case 
sensitive.  Passwords can be altered by the user from within the program. 
 

Private Operator Only passenger carrying operations using turbine or large aircraft have 
specific requirements for flight duty time, flight time and rest.  These are 
similar to the Part VII airline operations but even less restrictive.  Private 
operators in other non-passenger carrying specialty operations have no 
requirements under the CARs for flight duty time, flight time and rest. 
FLTDUTY XLS 2.06 shows the Part VI CARs in the text box and applies these 
limits when Private Op (Passenger) is checked in the “Special” list. 
 

Recognized date 
format 

Any combination of characters that Windows will recognize as a date.  
Whether day appears before month depends on Control Panel settings for 
your computer (English (United States) = month before day, English (Canada) 
= day before month).  Your computer MUST BE SET TO English(Canada)  
Examples for July 9, 2000 (Canadian):  “9/7/00”, “9/7/2000”, “07/09/00”, “July 
9, 2000”, “9-Jul-00”, “9-July-2000”, “9 July 2000”, “9 Jul 00”, “Jul 9, 2000”  
FLTDUTY XLS 2.06 will prompt you if your entry is not in a correct format.  
The display of dates will always be like “Jul 9, 2000” or “Jul 9/00”. 
 

Recognized time 
format 

Any combination of characters that Windows recognizes as a time. FLTDUTY 
XLS 2.06 also accepts 4 digits with no separator on a 24-hour clock.  
Examples for 9 o’clock in the morning:  “9:00:00”, “09:00”, “9:00:00 AM”, “9:00 
AM”, “9:00 am”, “900”, “0900” 
Examples for 9 o’clock at night:  “21:00:00”, “21:00”, “9:00:00 PM”, “9:00 PM”, 
“9:00 pm”, “2100”  
FLTDUTY XLS 2.06 will prompt you if your entry is not in a correct format.  
The display of times will always be like ”09:00 AM” and  “09:00 PM”. 
 

Recreational flying Any flying done by the pilot that is not for a commercial or private operator 
including flight training if done outside the work environment. This is not 
considered flight duty time, is considered time free from duty and does 
accumulate for total flight times.  Example:  pilot flying private aircraft, or 
training done for upgrade or renewal.   (Ultralight pilots, aircraft owners, 
instrument rating renewal) 
Enter as total flight time with no Report or Released times.  Check recreational 
flying in “Special” list  (There will be a prompt). 
 

Regulations For FLTDUTY XLS 2.06, the relevant regulations are in the CARs, Part VII, 
Division II, 700.14 to 700.23 and Part VI, Subpart 4, Division IV, 604.26 to 
604.33.  These are the actual regulations governing flight time, flight duty time 
and rest requirements and limits.  (See Standards)  
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Released from Duty 
time 

This is the time of day that the pilot completes the flight and any related 
duties.  After being released from duty the pilot is free to leave and is not 
responsible for any flight related duties and his time is his own (except for the 
responsibility to get the required rest).  If the pilot, on completion of a flight, is 
expected to remain on site for further assignment, then the flight duty time 
continues as standby time.  If the pilot is released with the expectation that he 
can be recalled (with less than 1 hour notice), then a new period of “On Call” 
status begins after he is released from the current flight duty. 
Enter as a time of day in a recognized time format. 
 

Report for Duty time This is the time of day that the pilot reports either for standby or a flight.  On a 
schedule, this would be the time expected for the pilot to be at work, on site, 
ready to go flying.  This time includes any pre-flight and related duties but 
does not include traveling. 
Enter as a time of day in a recognized time format. 
 

Rest Period Since 
Last Duty 

This value appears in Section 2: Daily Times as a calculated value for the 
maximum rest that could have been obtained between flight duty times 
entered in the schedule.  If the gap between duty periods is overnight, the 
value here is the time between the latest period on the previous date, and the 
earliest period on the entry date minus 1 hour.  This represents the maximum 
time that could be devoted to rest after meals, hygiene and travel have been 
assigned a minimum period of 1 hour. 
FLTDUTY XLS 2.06 offers this calculation as a maximum.  The value can be 

changed to reflect actual circumstances by clicking on Change and entering 
the time.  Some impossible combinations will be disallowed. 
 

Second Next 
Mandatory Day Off 

A calculated date assuming no days off are given between the entry date and 
the next mandatory day off, then the next mandatory day off is given.  The 
second next mandatory day off is the next date requiring a scheduled day off.  
This date can be consecutive with the next mandatory day off or not, 
depending on the requirements and the previous schedule. 
FLTDUTY XLS 2.06 warns of the Second Next Mandatory Day Off so that 
scheduling options can be exercised while there is still time.  A consecutive 
date with the Next Mandatory Day Off shows that there is a day off debt 
building up and more discretion in scheduling is indicated. 
 

Security Features FLTDUTY can be setup to open with a password.  Users can be assigned to 4 
different security clearance levels with corresponding user privileges.  
Administrators have control over setting the users/passwords and clearance 
levels.  Operational users cannot delete pilot records or change clearance 
levels, but they can change their own password.  Single Pilot users can open 
their own pilot record and make entries but cannot open or change any other 
record.  They can change their own password.  Read Only users can open all 
pilot records but cannot permanently save any entries or changes.  They can 
change their own password. 
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Split Duty Day (1)  For Aerial Application operations 
A split duty day occurs when rest is less than 8 hours overnight, and some 
midday rest is supplied to make up.  This is not a violation of the rest 
requirements as long as the pilot is warned ahead of time of the situation.  
There are restrictions for total flight duty time extending for 24 consecutive 
hours rather than consecutive hours of duty.  The required time free from duty 
is increased from 3 days in 30 days to 5 days off in 30 days and the extension 
option to 42 days without a day off is not available.  See CARs 720.16 (5).  
Example:  A spray pilot has several consecutive days of early morning and 
evening spray sessions, but has midday rests. 
Enter as more than 1 duty period (if that is the case) and check Aerial 
Application in the “Special” list.  If the actual rest and flight duty time is 
different from the calculated maximums, enter a change manually. 
 
(2)  For non-Aerial Application operations 
A split duty day occurs when the flight duty time is extended beyond the 
normal limits, but a rest period in suitable accommodation was supplied 
during the flight duty period.  This is not a violation of the daily flight duty time 
limits if there was forewarning and appropriate rest.  Rest requirements for the 
next flight duty period are increased because of the extended flight duty time.  
Example:  A charter pilot has an early flight and is laid over for the day with a 
late return.  If he is expected to hang out in the pilot lounge all day, a violation 
will occur after 15 hours of flight duty time.  If he is sent to a motel to rest, a 
split duty day results and no violation. 
Enter as more than 1 duty period around the midday rest period.  If the total 
flight duty time is over the normal limit, the “Split Duty Day” label will appear 
automatically and no violation will be incurred if the other requirements are 
satisfied. 
 

Standards For FLTDUTY XLS 2.06, the relevant standards are in the CARs, Part VII, 
Division II, 720.14 to 720.23 for commercial operators and Part VI, Subpart 4, 
Division IV, 624.29 to 624.30 for private operators.  These are the 
interpretation of the regulations and in some cases variances for special 
circumstances.  The reference number for the standard will be the same as 
the regulation to which it applies plus 20.  (ie. 720.15 is the standard for 
700.15) 
 

Standby Flight duty status that involves being at a specific location to be available for a 
flight within 1 hour or less and counts as flight duty time even if no flight is 
associated with the flight duty time.  Example:  Pilot required to be at the 
airport even when no flights actually scheduled.  (Instructors, charter pilots 
with other duties, fire suppression pilots) 
Enter as Report and Released time with no flight time. 
 

Third Next 
Mandatory Day Off 

A calculated date assuming no days off are given between the entry date and 
the next mandatory day off, then the next mandatory day off is given, and the 
second next mandatory day off is given without days off in between.  The third 
next mandatory day off is the next date requiring a scheduled day off.  This 
date can be consecutive with the second next mandatory day off or not, 
depending on the requirements and the previous schedule. 
FLTDUTY XLS 2.06 warns of the Third Next Mandatory Day Off so that 
scheduling options can be exercised while there is still time.  A consecutive 
date with the Second Next Mandatory Day Off shows that there is a day off 
debt building up and more discretion in scheduling is indicated. 
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LIMITED WARRANTY 
The author reserves the right to make improvements in the product described in this manual at any 
time and without notice. 

This program will perform substantially in accordance with the published specifications, 
documentation and authorized advertising.  The author, when notified of significant errors within 90 
days of purchase, will at his discretion either correct demonstrable and significant program errors 
within a reasonable period of time or provide a refund. 

The author does not warrant that the functions of the software will meet your requirements, or that 
the software will operate error free or without interruptions, or that you will be free from prosecution 
from regulatory authorities solely as a result of using this product.  The author has used reasonable 
efforts to minimize defects or errors in the software and errors in the interpretation of the 
regulations.  You assume the risk of any and all damage or loss from use or inability to use the 
software. 

The author makes no other warrants, express or implied, with respect to the manual or the software 
described in this manual.  In no event shall the author be liable for direct or indirect, incidental or 
consequential damages resulting from any defect in the software, even if the author has been 
advised of the possibility of such damages. 

 
 
Thanks! 
Special thanks to John Lavigne, past Chief Pilot for Forest Protection Limited, for his continued 
support and enthusiasm in seeing this project through.  

Thanks to Transport Canada staff in Ottawa:  John Hamilton for getting me started and Judy 
Adamson for patiently answering all my questions, Roger Ayotte for continuing interpretations. 
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APPENDIX 

CHANGING THE SPLASH SCREEN PHOTO 

If you have a photo you want to use in the splash screen (the first screen you see when you open 
FLTDUTY XLS), you can create a Bitmap image of your own and place it in the FLTDUTY XLS 
folder. 

The original bitmap image was created using Paint in Windows 95 after exporting a scanned photo 
from Adobe PhotoShop.  The bitmap image attributes are Width 4.94” and Height 2.31”.  You will 
need to create an image of the same dimensions for it to fit in the form.  If your photo is a different 
size, use the Paint features to crop or stretch your image to fit in a file with the attributes 4.94” x 
2.31”. 

One way to accomplish the fit is to create a blank file in Paint with the attributes set to 4.94” x 2.31” 
size; then copy your scanned photo in a larger size and paste it to the sized file without expanding 
the attributes to fit your photo.  Position the pasted image for the best display within the set 
dimensions and save it  

Once you are satisfied with your 4.94” x 2.31” BMP file, save it as SplashScreen.bmp.  Transfer this 
file (only a file named SplashScreen.bmp will be recognized) to C:\FLTDUTY XLS and when you 
open your copy of FLTDUTY, your new photo will be in place. 

 

CHANGING THE COMPANY NAME 

You might want to alter the company name text that appears in the Splash Screen and on the 
header of the reports.  You can make the form appear to make this entry by right clicking on the 
splash screen anywhere when it is in view at startup.  The original form will be displayed and you 
can make changes in the text box and close.  This can be left blank, set to upper or lower case 
letters, or changed as desired. 
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